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Pro Tools TDM System Requirements

Pro Tools software runs on a variety of
TDM system hardware configurations in-
cluding:

Pro Tools 24 MIX™ /MIXplus™ Include a
Pro Tools MIX card (two MIX cards in the
case of a MIXplus system), and your choice

of the 888/24 1/0, 882/20 1/0, 1622 1/0O, or

ADAT Bridge I/O. A core system provides:

e Up to 64 tracks of recording/playback of
24-bit and 16-bit audio files

e TDM digital mixing and DSP Plug-In en-
vironment

¢ Non-linear, random-access editing and
mix automation

e MIDI recording, playback and editing

Pro Tools 24™ Includes a d24 audio card, a

DSP Farm, and your choice of the

888/24 1/0, 882/20 1/0, 1622 1/0, or ADAT

Bridge I/O. A core system provides:

e Up to 32 tracks of recording/playback of
24-bit and 16-bit audio files

e TDM digital mixing and DSP Plug-In en-
vironment

e Non-linear, random-access editing and
mix automation

e MIDI recording, playback and editing

Pro Tools llI™ Includes a Disk I/O card, a

DSP Farm, and your choice of the

888/24 1/O or 882/20 I/O. A core system

provides:

e 16 tracks of recording/playback of 16-bit
audio files.

e TDM digital mixing and DSP Plug-In en-
vironment

¢ Non-linear, random-access editing and
mix automation

e MIDI recording, playback and editing

System Requirements

The CPU, hard disk, monitoring and MIDI
requirements for Pro Tools differ depend-
ing your system configuration and com-
puter platform (Macintosh or Windows).
The requirements for each configuration
are listed below.

CPU Requirements

Macintosh

o A Digidesign-qualified, PCI-based Power
Macintosh computer with:

e Atleast 128 MB RAM. For 64-voice per-

formance, 192 MB of RAM is required.
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¢ Additional RAM is highly recom-
mended if you plan to use other audio
or MIDI applications concurrently
with Pro Tools. Virtual memory is not
supported.

0 Apple System software version 8.6 or
higher.

o Apple QuickTime System Extension ver-
sion 4.0 or higher (included with Pro Tools)

0 OMS (Open Music System) software (in-
cluded with Pro Tools)

0 A 17-inch or larger color monitor. Black
and white monitors are not supported.

Windows NT

o A Digidesign-qualified, uniprocessor
Pentium II or Pentium IlI-based computer
running at 233 MHz or faster with:

e At least 192 MB of RAM. For 64-voice
performance, 256 MB of RAM is re-
quired.

¢ 1 unused PCI slot for Pro Tools 24 MIX
systems. 2 unused adjacent PCI slots
for Pro Tools 24 or Pro Tools 24 MIX-
plus systems. Expanded systems re-
quire additional unused adjacent PCI
slots or an expansion chassis.

e Intel 440LX or 440BX chip set

¢ Phoenix or Award BIOS

e a CD-ROM drive

e an AGP display card is strongly recom-
mended

o Windows NT, Workstation Edition, ver-
sion 4.0 with Service Pack 4 or higher.

0 A 17-inch or larger color monitor. Black
and white monitors are not supported.
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Hard Drive Requirements
Macintosh

Pro Tools 24 MIX and MIXplus Require one
or more Digidesign-approved SCSI drives
attached to a qualified PCI SCSI accelerator
card for audio recording and storage. For
best 64-track, 24-bit performance, use at
least 4 hard drives, with audio files distrib-
uted among them.

Pro Tools 24 Requires one or more
Digidesign-approved SCSI drives attached
to the internal or external Macintosh SCSI
chain or a qualified PCI SCSI accelerator
card for audio recording and storage. For
best 32-track, 24-bit performance, use at
least 2 hard drives, with audio files distrib-
uted among them.

Pro Tools IlIl Requires one or more
Digidesign-approved external SCSI drives
attached to the Pro Tools Disk I/O for au-
diorecording and storage. An external SCSI
drive cannot be used as a Startup drive.

Windows

Pro Tools 24 MIX and MiXplus Require one
or more Digidesign-approved SCSI drives
attached to a qualified PCI SCSI accelerator
card or the embedded SCSI connector on
the motherboard for audio recording and
storage. For best 64-track, 24-bit perfor-
mance, use at least 4 hard drives, with au-
dio files distributed among them.

Pro Tools 24 systems Require one or more
Digidesign-approved SCSI drives attached
to a qualified PCI SCSI accelerator card or
embedded SCSI connector on the mother-
board for audio recording and storage. For
best 32-track, 24-bit performance, use at



least 2 hard drives, with audio files distrib-
uted among them.

A EIDE drives are not supported for use as au-
dio drives on Windows-based Pro Tools sys-
tems. If you wish to use an EIDE drive as a
system drive, or an IDE based CD-ROM drive,
the Intel PIIX IDE driver for Windows NT 4.0 is
required. This driver is provided on the

Pro Tools Installer CD-ROM. See the Pro Tools
Software Installation Guide for details.

A If you are using an Expansion Chassis with
a Windows-based Pro Tools system, IDE drives
and drivers must be removed from your sys-
tem. For more information, see the Pro Tools
Expanded System Installation Guide.

MIDI Requirements

Macintosh

0 OMS software (included with Pro Tools)

0 A Macintosh-compatible MIDI Interface

o A MIDI controller and/or sound modules

Windows

o A Windows-compatible MIDI Interface
o0 A MIDI controller and/or sound modules

Additional Requirements
for Blue & White G3
Macintosh Computers

The Apple Power Macintosh G3, also
known as the Blue & White G3, requires ad-
ditional hardware to run Pro Tools. The re-
quirements are given below for each type
of Pro Tools system.

Pro Tools 24 MIX/MIXplus and
Pro Tools 24

External Diskette Drive A qualified floppy
drive, along with the appropriate driver
software (included on the Pro Tools In-
staller CD-ROM)), is required to authorize
Pro Tools software and Digidesign Plug-Ins.

SCSI Accelerator card A qualified SCSI Ac-
celerator card is required to connect audio
drives to Blue & White G3 computers.

ATA system drive Pro Tools requires the
standard ATA system drive and not the op-
tional Apple SCSI drive for Blue & White
G3 computers.

Pro Tools Il

External Diskette Drive A qualified floppy
drive, along with the appropriate driver
software (included on the Pro Tools In-
staller CD-ROM)), is required to authorize
Pro Tools software.

ATA system drive Pro Tools requires the
standard ATA system drive and not the op-
tional Apple SCSI drive for Blue & White
G3 computers.

MIDI Connectivity

To use a MIDI Interface with Pro Tools on
the Blue & White G3, the interface must be
USB compatible. Alternatively, you can use
a card such as the Griffin Technologies
gPort™ which connects to the internal mo-
dem port and provides a serial port connec-
tion suitable for most MIDI applications.
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USD Connectivity

To use a Digidesign Universal Slave Driver
with the Blue & White G3, it must be con-
nected to the DigiSerial port on a Digide-
sign card. Only Pro Tools 24 and

Pro Tools 24 MIX/MIXplus systems have
DigiSerial ports.

MachineControl

To use MachineControl with the

Blue & White G3, use the DigiSerial port
on the Pro Tools d24 or MIX card, or add a
qualified external USB-to-Serial port con-
vertor to use the Apple USB port on the
computer.

Audio Requirements

To record and play audio you must have:

0 An audio amplifier and speakers, or self-
powered speakers

0 Optionally, a mixing console and sound
source. Depending on which system and
Audio Interface you are using, this device
must be equipped with the appropriate
connections. The connections and operat-
ing levels for Digidesign Audio Interfaces
are as follows:

888/241/0
0 Analog: XLR (balanced or unbalanced)
connectors, +4 dBu or -10 dBV

o Digital: XLR (AES/EBU) or RCA (S/PDIF)
connectors
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882/201/0

0 Analog: 1/4" TRS (balanced or unbal-
anced) connectors, +4 dBu or -10 dBV
o Digital: RCA (S/PDIF) connectors

16221/0

0 Analog: 1/4" TRS (balanced or unbal-
anced) connectors. Inputs are variable from
+4 dBu to -10 dBV; outputs are selectable
between +4 dBu or -10 dBV.

o Digital: RCA (S/PDIF) connectors

Digidesign ADAT Bridge 1/0
0 Analog: 1/4" TRS (balanced) connectors,
+4 dBu or -10 dBV

0 Digital: XLR (AES/EBU) or RCA (S/PDIF)
connectors

o Optical: Two pairs of EIA]J fiber optic con-
nectors

Compatibility Information

Digidesign can only assure compatibility
and provide support for devices it has
tested and approved.

For a list of qualified computers, diskette
drives, SCSI accelerators, serial port conver-
tors and hard drives, refer to the latest
Digidesign compatibility documents, avail-
able from Digidesign by fax or on the
Digidesign website.

O See the title page of this guide for
Digidesign’s contact information.



Installing Pro Tools Hardware

The order in which you install Pro Tools
software and hardware depends on which
computer platform you are using.

Macintosh

On Macintosh systems, install Pro Tools
software first, so you can use the DigiTest
utility to determine proper card order in
your computer. Refer to the Pro Tools Soft-
ware Installation Guide before installing
Pro Tools hardware. Finish by installing
Pro Tools hardware.

Windows NT

On Windows NT systems, run the Install-
O-Rator utility first, to configure your sys-
tem to properly recognize Pro Tools hard-
ware. Refer to the Pro Tools Software Instal-
lation Guide before installing Pro Tools
hardware. Install Pro Tools hardware next,
and finish by installing Pro Tools software.

Expanded Pro Tools Systems

If you are installing an expanded system in
your computer, or using an Expansion
Chassis to add additional cards to your sys-
tem, refer to the Expanded System Installa-
tion Guide included with your Pro Tools
system.

The Pro Tools Cards

Your Pro Tools cards will differ depending
on your system configuration. Card com-
ponents for each configuration are listed
below.

Pro Tools 24 MIX Hardware

Pro Tools 24 MIX hardware comes in two
configurations:

Pro Tools 24 MIX Includes a single MIX
Core card and a 5-node TDM ribbon cable
for connecting it with other optional TDM-
equipped cards.

Pro Tools 24 MiXplus Includes a MIX Core
card, a MIX Farm card, and a 5-node TDM
ribbon cable for connecting the MIX Core
to the MIX Farm and other optional TDM-
equipped cards.
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The MIX Core Card

The MIX Core card provides 24-bit, 64-
track, 16-channel I/O, direct-to-disk re-
cording and playback to your Pro Tools 24
MIX system, as well as DSP power for its
mixing and processing capabilities.

audio interface — ||+ =
port =

DigiSerial port

MIX Core card

This card includes a connector for attach-
ing a single 888/24 1/0, 882/20 1/O, or
1622 1/O Audio Interface. If you purchase
the optional 16-channel peripheral cable
adapter, you can attach two 8-channel Au-
dio Interfaces. The DigiSerial port is for
connecting a Digidesign Universal Slave
Driver, or a 9-pin device for use with the
Pro Tools MachineControl option.

The MIX Farm Card

The MIX Farm card provides more DSP
power for mixing, processing, and DSP
software such as the DigiRack Plug-Ins in-
cluded with Pro Tools. It also provides a
connector for attaching a single

888/24 1/0, 882/20 1/0, or 1622 I/O Audio
Interface. If you purchase the optional 16-
channel peripheral cable adapter, you can
attach two 8-channel Audio Interfaces.
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audio interface — ||+
port

DigiSerial port

MIX Farm card

Pro Tools 24 Hardware

Pro Tools 24 Core System hardware con-
sists of a d24 audio card, a DSP Farm card,
and a 5-node TDM ribbon cable for con-
necting them together.

The d24 Audio Card

The d24 audio card provides 24-bit, 32-
track, 16-channel I/O, direct-to-disk re-
cording and playback capabilities to your
Pro Tools 24 system. It also provides a con-
nector for attaching a single 888/24 1/0,
882/20 1/0, or 1622 I/O Audio Interface. If
you purchase the optional 16-channel pe-
ripheral cable adapter, you can attach two
8-channel Audio Interfaces.

port
DigiSerial port

d24 card

The DigiSerial port is for connecting an op-
tional Digidesign Universal Slave Driver, or
a 9-pin device for use with the Pro Tools
MachineControl option.



The DSP Farm

The DSP Farm provides the power for the
Pro Tools 24 system’s mixing and process-
ing capabilities. It powers DSP software
such as the DigiRack Plug-Ins included
with Pro Tools. It also provides a connector
for attaching an 8-channel Audio Interface.

audio interface
port

DSP Farm card

A The 1622 1/0 Audio Interface is not sup-
ported by the DSP Farm. It must be connected
to a MIX Core, MIX Farm, or d24 card. Only one
1622 1/0 can be connected to any of these
cards. The optional 16-channel peripheral ca-
ble adapter is not supported by the 1622 1/0.

Pro Tools IIl Hardware

A Pro Tools III Core System consists of a
Disk I/O card, a DSP Farm card, a 5-node
TDM cable for connecting the two, and a
custom SCSI cable for connecting SCSI
drives directly to the Disk I/O card.

The Disk 1/0 Card

The Disk I/O card provides the 16-bit, 16-
track, 8-channel I/O, direct-to-disk record-
ing and playback capabilities of your sys-
tem. It also provides a connector for attach-
ing a SCSI hard drive and an I/O connector
for attaching an 8-channel Audio Interface.

Disk 1/0 card

The DSP Farm

The DSP Farm provides the DSP power for
the Pro Tools III system’s mixing and pro-
cessing capabilities. It powers DSP software
such as the DigiRack Plug-Ins included
with Pro Tools. It also provides a connector
for attaching an 8-channel Audio Interface.

audio interface
port

DSP Farm card

The TDM Ribbon Cable

The TDM ribbon cable is used to connect
multiple cards in your Pro Tools system so
they can share data along the TDM Bus.

TDM Ribbon Cable

A 5-node cable comes with your system. If
you plan to use your system with an expan-
sion chassis, you can order a TDM cable
with more nodes from your Digidesign
dealer.

Chapter 2: Installing Pro Tools Hardware



Installing the Pro Tools
Cards

The first step in your hardware installation
is installing the Pro Tools cards.

Macintosh Systems

On Macintosh systems, Pro Tools cards
must be installed in a specific order that is
dependent on the slot numbering of the
model of Macintosh you are using.

O See Appendix A: Determining Slot Order
On Macintosh Computers for details on deter-
mining slot order in your system.

To install the Pro Tools cards:

1 Turn off your computer. Leave it plugged
in so that it is grounded.

2 Open the computer case. The illustra-
tions in this section show a Blue & White
Macintosh G3 and a Macintosh 9600 com-
puter. If you are using a different model,
your installation should be similar. For ad-
ditional details on installing a card in your
computer, refer to its User’s Guide.

A Before handling any card, discharge any
static electricity that may be on your clothes or
body by touching a grounded metal surface,
such as the power supply case inside your
computer.

3 Remove the metal access port cover be-
hind the expansion slot you wish to use by
removing the screw (if present) and sliding
the cover out from the access port.

4 Remove the Core Pro Tools card
(MIX Core, d24, or Disk 1/0O) from its pro-
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tective antistatic bag. Align the card with
the appropriate expansion slot and push
the card into the PCI connector until it is
fully inserted in the slot. Avoid flexing the
card or putting undue pressure on your
computer’s motherboard.

Installing a Pro Tools card in a Macintosh G3

Installing a Pro Tools card in a Macintosh 9600

5 Unpack any additional Pro Tools cards
and remove their antistatic bags, observing
the same precautions as before.

6 Plug the additional cards into subsequent
slots beginning with the slot adjacent to



the primary Pro Tools card. Group similar
cards together (put all MIX Farm cards next
to each other, for example).

7 Connect all TDM-equipped cards with
the TDM ribbon cable.

Connect the first node of the cable to the
first card, then attach the remaining nodes
on the cable to subsequent cards.

There are white triangles on the plugs of
the TDM ribbon cable and on your

Pro Tools cards. Match these triangles to
make sure the TDM ribbon cable is turned
the right direction.

Push down gently but firmly until the node
is fully connected to the card. When the
plug is properly seated, the two tabs on the
side of the cable’s TDM connector will click
shut. To detach the ribbon cable, squeeze
the tabs on the TDM connector inward.

O It is OK to have ribbon connectors that go
unused. They should reside after the last TDM-
equipped card.

Attaching the TDM ribbon cable to MIX Core and
MIX Farm cards

8 Secure the cards in place with the slot ac-
cess port screws you removed earlier and
close your computer.

Windows Systems

To install the Pro Tools cards:

1 Make sure your computer is turned off.
Leave it plugged in so that it is grounded.

2 Remove the computer’s cover. The illus-
tration depicts installation in a standard 4-
slot, ATX motherboard-based PCI com-
puter. Your installation should be very sim-
ilar.

3 Look at the available PCI slots in the
computer. Pro Tools 24 MIXplus and

Pro Tools 24-based systems require a mini-
mum of two adjacent PCI slots. These two
adjacent slots should be located closest to
the AGP port or power supply of the com-
puter.

A Before handling any card, discharge any
static electricity that may be on your clothes or
body by touching a grounded metal surface,
such as the power supply case inside your
computer.

4 If you already have one or more PCI cards
(such as a modem or SCSI accelerator) in ei-
ther of the two slots closest to the power
supply, remove the rear-panel screw that
holds each card in place and place the cards
in the slots farthest away from the power
supply to make room for the Pro Tools
cards.

5 After reordering your existing PCI cards,
restart your computer and make sure that
the cards are still recognized in their new
slot locations. The best way to do this is to
watch for error messages during startup
and to open and use any software which
accesses the cards to confirm proper opera-
tion.
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6 If the cards are recognized, shut down
your computer, secure the cards with the
screws you removed earlier, and proceed
with the Pro Tools card installation.

7 Remove the metal access port cover be-
hind the expansion slots you wish to use
by removing the screw and sliding the
cover out from the access port.

8 Remove the MIX Core or d24 card from
its protective antistatic bag. Align the card
with the appropriate expansion slot and
push the card into the PCI connector until
it is fully inserted in the slot. Avoid flexing
the card or putting undue pressure on your
computer’s motherboard.

Installing a Pro Tools card in a PC

9 If you have a Pro Tools 24 MIXplus sys-
tem, unpack the MIX Farm card and re-
move it from its antistatic bag, observing
the same precautions as before.

10 Plug the MIX Farm card into the PCI
slot adjacent to your MIX Core card. If you
have additional MIX Farm, DSP Farm, or
MIX I/O cards, install them in subsequent
slots. Group similar cards together (put all
MIX Farm cards next to each other, for ex-
ample).

10 Pro Tools TDM Hardware Installation Guide

11 Connect all TDM-equipped cards with
the TDM ribbon cable.

Connect the first node of the cable to the
first card, and attach the remaining nodes
on the cable to subsequent cards.

There are white triangles on the plugs of
the TDM ribbon cable and on your

Pro Tools cards. Match these triangles to
make sure the TDM ribbon cable is turned
the right direction.

Push down gently but firmly until the node
is fully connected to the card. When the
plug is properly seated, the two tabs on the
side of the cable’s TDM connector will click
shut. To detach the ribbon cable, squeeze
the tabs on the TDM connector inward.

Attaching the TDM ribbon cable to the Mix Core and
Mix Farm cards

O It is OK to have ribbon connectors that go
unused. They should reside after the last TDM-
equipped card.

12 Secure the cards in place with the slot
access port screws you removed earlier and
close your computer.



Connecting an Audio
Interface

Pro Tools provides you with a choice of the
888/24 1/0, 882/20 1/0, 1622 1/0, or ADAT
Bridge I/O Interfaces. These devices supply
the inputs and outputs for your system.

O For instructions on connecting an ADAT
Bridge 1/0, see the ADAT Bridge 1/0 Installa-
tion Guide.

The appropriate I/O peripheral cable for
connecting an Audio Interface to your
Pro Tools card is included with your Audio
Interface. If you wish to connect a second
Audio Interface to a MIX or d24 card, you
can purchase the optional 16-channel pe-
ripheral cable adapter from your autho-
rized Digidesign reseller.

0O The 1622 1/0 is a 16-channel audio inter-
face. Its supplied cable carries all 16 chan-
nels, and does not require an adapter.

The 888/24 1/0 Audio Interface

The 882/20 I/0 Audio Interface

The 1622 I/0 Audio Interface

Using Multiple Pro Tools Cards
and Interfaces

If you have multiple Pro Tools cards and
Audio Interfaces, the Audio Interface that
you want to function as clock master for
your system must be connected to your
core Pro Tools card.

On Macintosh computers, the core

Pro Tools card is the card in the lowest-
numbered PCI slot inside the CPU—typi-
cally the one nearest the computer’s power
supply. (Subsequent PCI slots are num-
bered sequentially in ascending order.)

On Intel-based computers, PCI slots are not
numbered sequentially according to their
physical location inside the CPU. For this
reason, you must launch the DigiTest™ util-
ity before running Pro Tools to determine
the slot numbering for installed cards.

For more information on using DigiTest to
confirm card/slot order, see “Configuring
Expanded Pro Tools Systems” on page 51.

To connect the Audio Interface:

1 Carefully unpack the Audio Interface.
Depending on how your studio is set up,
you may wish to make audio and power
connections before you mount the Audio
Interface in your rack.

Chapter 2: Installing Pro Tools Hardware
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2 If you are using two or more Audio Inter-
tfaces with your Pro Tools system, connect
them together at the Slave Clock In/Out
ports using the enclosed BNC cables as
shown in the illustration that follows.

The “master” Audio Interface should be
connected to the core Pro Tools card. On
Macintosh computer’s this is typically the
card nearest the computer’s power supply.
If you connect two Audio Interfaces to a
MIX Core or d24 card using the optional
16-channel peripheral cable adapter, the
master interface is the one connected to
the cable labeled “Interface A.”)

]
00 { #Y|° °

uuuuuu

00000000 0O000000 | ©_ {°

Connecting multiple Audio Interfaces together

3 Connect the interface cable to your core
Pro Tools card as shown in the illustrations.
Gently push the cable’s connector into the
card’s interface port and secure the connec-
tor in place with its thumbscrews.

to Audio Interface to Pro Tools card

The Audio Interface cable
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Connecting the interface cable to a MIX Core card

Connecting the interface cable to a d24 card
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Connecting the interface cable to a Disk I/0 card

4 If you have two 8-channel Audio Inter-
faces and wish to connect both of them to
a MIX Core or d24 card, you may do so by
purchasing Digidesign’s 16-channel pe-
ripheral cable adapter. Connect the single
end of the Y-cable to the MIX Core or d24
card as shown in the illustration that fol-
lows. Gently push the cable’s connector
into the card’s interface port and secure the
connector in place with its thumbscrews.



A Because the 1622 I/0 is a 16-channel de-
vice, it uses all 16-channels of I/0 on a

Pro Tools MIX or d24 card. A second interface
cannot be connected.

to Audio to Audio
Interface  Interface
cable cable

L

to Pro Tools card

—

The optional 16-channel peripheral cable adapter

Y-cable to audio interface cable

Connecting the 16-channel peripheral cable adapter
to a MIX Core card

5 Connect the other ends of the Y-cable to
the Audio Interface cables. (The Y portion
of the cable is labeled “Interface A” and
“Interface B” for reference.)

6 Connect the Audio Interface cable to the
back of the Audio Interface. (If you have
two interfaces and the optional 16-channel
peripheral cable adapter, connect each ca-
ble to an interface.) To do this, pinch the
tabs on either side of the connector and
push it into the port labeled “Computer”
on the rear of the Audio Interface. Release
pressure on the metal tab to lock the con-
nector into place.

to audio interface

Connecting the 16-channel peripheral cable adapter
to the Audio Interface cables

Connecting the interface cable to the 1622 I/0

Chapter 2: Installing Pro Tools Hardware
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7 If you have additional Audio Interfaces
and Pro Tools cards, connect the Audio In-
terfaces to corresponding cards with the in-
terface cables.

A The 1622 1/0 Audio Interface is not sup-
ported by the DSP Farm. It must be connected
to a MIX Core, MIX Farm, or d24 card.

If you are connecting both 888/24 and
882/20 or 1622 1/O Audio Interfaces to
your system, for best system performance,
connect the 888/24 to your core Pro Tools
card, followed by any additional 888/24 In-
terfaces to the next highest-priority cards.
Then connect the 882/20 or 1622 1/0 inter-
faces to subsequent cards.

O If you have an ADAT Bridge 1/0, see the
ADAT Bridge 1/0 Installation Guide for spe-
cial installation guidelines.

8 Connect the power cable to the rear of
each Audio Interface. The Audio Interface
automatically selects the power setting for
use with the standard voltage and fre-
quency in any country. Simply connect the
power cable appropriate to your local
power standard and the Audio Interface
will function normally.
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Connecting SCSI Drives

Pro Tools is a disk-based recording system.
As such, SCSI hard drives function as the
recording media and it is there that

Pro Tools sessions and audio files are kept.

Audio Storage Guidelines

Audio tracks recorded at 24-bit resolution
at a CD-fidelity sampling rate of 44.1 kHz
require about 7.5 MB of hard disk space per
minute. The same tracks recorded at 16-bit
resolution require about 5 MB per minute.

Using these guidelines:

e 64 tracks of 24-bit audio takes up about
480 MB of hard disk space per minute.

e 64 tracks of 16-bit audio takes up about
320 MB of hard disk space per minute.

e 32 tracks of 24-bit audio takes up about
240 MB of hard disk space per minute.

e 32 tracks of 16-bit audio takes up about
160 MB per minute.

A 9-gigabyte drive holds:

18 minutes of 64 track, 24-bit audio
28 minutes of 64 track, 16-bit audio
37 minutes of 32 track, 24-bit audio
56 minutes of 32 track, 16-bit audio

A Digidesign can guarantee optimum and reli-
able performance only when Digidesign-quali-
fied hard drives and SCSI accelerators are
used. Contact your Digidesign dealer or visit
Digidesign’s website for a list of approved hard
drives and SCSI accelerator cards.

SCSI Requirements

Each Pro Tools configuration has specific
SCSI requirements:

Pro Tools 24 MIX and MIXplus These sys-
tems require one or more Digidesign-
approved SCSI drives attached to a quali-
fied PCI SCSI accelerator card, or on Macin-
tosh computers, the internal or external
Macintosh SCSI chain. For best 64-track,
24-bit performance, use at least 4 hard
drives, with audio files distributed among
them.

Pro Tools 24 These systems require one or
more Digidesign-approved SCSI drives at-
tached to a qualified PCI SCSI accelerator
card, or on Macintosh computers, the in-
ternal or external Macintosh SCSI chain.
For best 32-track, 24-bit performance, use
at least 2 hard drives, with audio files dis-
tributed among them.

Chapter 3: Connecting SCSI Drives

15



Pro Tools Ill These systems require one or
more Digidesign-approved external SCSI
drives attached to the Pro Tools Disk I/O
card for audio recording and storage. A
drive connected to the Disk I/O cannot be
used as a Startup drive.

SCSI on Power Macintosh
Computers

All Macintosh G3 computers currently re-
quire a SCSI accelerator for use with
Pro Tools.

Some older Power Macintosh models such
as the 9600 have two SCSI busses: an inter-
nal fast SCSI bus and an external slow SCSI
bus. Each bus allows you to connect up to 7
SCSI devices. For optimum Pro Tools per-
formance (without a SCSI accelerator), use
the internal/fast SCSI bus.

O While the internal and external SCSI busses
on older Power Macintosh models yield rea-
sonable performance on sessions with low
track counts, a SCSI accelerator card is re-
quired on sessions with high track counts and
high edit density.

Formatting Drives for
Macintosh-based Systems

SCSI hard drives used for audio recording
on Pro Tools for Macintosh systems must
be formatted for either the HES or HFS plus
file system. Drive partitions of up to

2 terabytes (2000 gigabytes) can be used.
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Pro Tools 24 MIX and Pro Tools 24

Pro Tools 24 MIX and Pro Tools 24 systems
require that you use FWB Software’s Hard
Disk ToolKit™ PE for drive formatting and
maintenance. This software is included
with Pro Tools. See the Hard Disk ToolKit
documentation for instructions.

Pro Tools lll Systems

On Pro Tools III systems, hard drives can-
not be initialized while they are connected
to the Disk I/O Card. Drives must be con-
nected to the Macintosh, initialized, then
reconnected to the Disk I/O card.

Formatting Drives for
Windows-based Systems

SCSI hard drives used for audio recording
on Pro Tools for Windows systems must be
formatted for the FAT16 or NTFS file sys-
tem. Drive partitions of up to 4095 MB can
be used.

See “Preparing SCSI Drives on Windows-
based Systems” on page 20 for instructions
on using Windows Disk Administrator to
format and partition each drive.

A The FAT32 specification is not supported by
Pro Tools. If you try to record audio to FAT32
partitions, errors and data loss may occur.

O Pro Tools for Windows NT allows you to con-
nect Macintosh-formatted hard drives and play
sessions created on Pro Tools for Macintosh.

See “Using Macintosh Drives on Windows Sys-
tems” on page 22.



Hard Drives Larger than 4
Gigabytes

The FAT16 file system only recognizes par-
titions up to 4 gigabytes in size (4095
megabytes) or smaller. The maximum size
for a single audio file is also 4095 MB.

If you have a hard drive that is larger than
4095 MB, you must partition the drive into
segments that are 4095 MB or smaller in or-
der to make use of the entire drive.

Later in this chapter you will learn how to
partition and format hard drives using the
Windows NT Disk Administrator software.

Improving System
Performance

The recording and playback performance
of Pro Tools 24 MIX and Pro Tools 24 sys-
tems depends largely on the speed and effi-
ciency of your SCSI devices. In particular,
sessions with high track counts and high-
density edits demand maximum SCSI per-
formance. Following the guidelines below
will help you get the most out of your sys-
tem.

Use High-Performance SCSI Drives

The faster a hard drive’s access time, the
better its performance. For 64 track, 24-bit
recording and playback, your SCSI hard
drives must provide a data transfer rate of
at least 9 MB per second of sustained
throughput.

Use a SCSI Accelerator

SCSI accelerator cards significantly im-
prove SCSI throughput. If you use a dual-
channel SCSI accelerator card, equally allo-
cate audio files to drives connected to each
of the two busses on the card for optimal
performance.

Distribute Audio Across Multiple
Drives

For best recording and playback perfor-
mance, don’t record and playback all audio
files in a session from the same drive. In-
stead, use Pro Tools disk allocation features
to distribute audio files between multiple
SCSI drives. See the Pro Tools Reference
Guide for details.

Minimize SCSI Cable Length

Using short SCSI cables improves reliabil-
ity. Table 1 provides guidelines for maxi-
mum cable lengths according to SCSI type.

Separate Video and Audio Files

If you are working with imported movies,
movie files must reside on a different SCSI
bus than audio files. If audio files reside on
disks connected to a SCSI accelerator card,
video data should reside on drives con-
nected to a different SCSI bus.

Chapter 3: Connecting SCSI Drives
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Table 1: Maximum cable length and number of drives
supported according to SCSI type

maximum #
of drives

maximum
cable length

SCSI type and
transfer rate

Fast SCSI 3 meters 8

10 MB/sec

Wide SCSI
20 MB/sec

3 meters 16

Ultra SCSI
20 MB/sec
(8-bit narrow)

3 meters 5

Ultra SCSI
40 MB/sec
(16-bit wide)

3 meters 5

Ultra SCSI
20 MB/sec
(8-bit narrow)

1.5 meters 6-8

Ultra SCSI
40 MB/sec
(16-bit wide)

1.5 meters 6-8

Ultra2 SCSI
Low Voltage Dif-
ferential (LVD)
80 MB/sec

12 meters 16

Connecting SCSI Drives to
Pro Tools MIX and
Pro Tools 24 Systems

To connect an external SCSI drive:

1 Turn off power to both the computer and
the hard drive.

2 Attach a SCSI cable from the SCSI port of
the hard drive to the SCSI port of the com-
puter or SCSI accelerator card depending
on your system’s SCSI requirements.
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3 Secure the cable’s connectors to the hard
drive and computer. Loose cables can cause
data loss.

4 Connect additional drives by daisy-
chaining from one drive to another. Keep
cable lengths to a minimum (see Table 1).

5 Verify that the last SCSI device connected
is properly terminated. (See “Proper
SCSI Chain Termination” on page 19.)

6 Attach power cables to the hard drives.

SCSI accelerator card

to SCSI hard drive

Connecting a SCSI cable to a SCSI accelerator card

8000
000¢ W
)

to SCSI accelerator card

Connecting an external SCSI hard drive



Proper SCSI Chain Termination

Your computer’s SCSI chain must be prop-
erly terminated or your system will not
function correctly. Only the last device on
the chain should be terminated using the
termination type recommended by the
hard drive manufacturer.

The drive should use either an external ter-
minator plug or have its internal termina-
tors enabled. If you are using a terminator
plug, Digidesign recommends that you
purchase and use an active terminator.

A Do not enable internal termination and in-
stall an external terminator plug on the same
drive! This will cause SCSI errors. See your
hard drive’s documentation for information re-
garding which type of termination it uses.

Connecting SCSI Drives To
Pro Tools 1l Systems

(Macintosh Only)

On Pro Tools III systems, audio drives must
be connected to the Disk I/O card. When
properly connected, they will appear on
the desktop like any other external SCSI de-
vice. A maximum of 5 hard drives can be
connected (by daisy-chaining) to a single
Pro Tools III Disk I/O card.

To connect an external SCSI drive:
1 Turn off power to both the computer and
the hard drive.

2 Connect the included SCSI cable to your
Pro Tools Disk I/O card as shown in the il-
lustration. Push the connector into the

SCSI port on the Pro Tools card and secure
it in place with its connectors.

The Disk I/0 SCSI cable

Disk 1/0 card

o
o
%02,
200000
)

to SCSI hard drive

Connecting the SCSI cable to the Disk I/0 card

to Disk 1/0 card

Connecting an external SCSI hard drive

3 Attach the other end of the SCSI cable to
one of the SCSI connectors on the back of
the external SCSI drive. Secure it in place
with its connectors.
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4 Connect any other drives by daisy-chain-
ing from one drive to another. Keep SCSI
cable lengths to a minimum. The overall
SCSI chain length should not exceed 3
meters, including the Pro Tools SCSI cable.

5 Verify that the last SCSI drive connected
to the Disk I/O card is properly terminated.
(See “Proper SCSI Chain Termination” on

page 19.)

6 Attach power cables to the hard drives.

Preparing SCSI Drives on
Windows-based Systems

The Windows NT Disk Administrator al-
lows you to partition and format SCSI hard
drives for use with Pro Tools. Disk Admin-
istrator also creates a disk signature on new
drives attached to your system. This signa-
ture allows Windows NT to recognize the
drives and assign them a drive letter. You
must run Disk Administrator whenever
you connect new drives to your system.

A You must run Disk Administrator before you
can use hard drives with Pro Tools.

To create a disk signature on a SCSI drive:

1 From the Start menu, choose Programs >
Administrative Tools > Disk Administrator

2 If there is no Windows NT disk signature
on the new drive(s), Disk Administrator
will post a dialog asking if you want to cre-
ate one. Click OK to create the signature.
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Formatting and Partitioning
Drives

Hard drives used as Pro Tools audio drives

must be formatted with the FAT16 file sys-
tem. This file system only recognizes parti-
tions up to 4 gigabytes (4095 megabytes) in
size.

If you have a hard drive that is larger than
4 gigabytes, you must partition it into seg-
ments that are 4095 MB or smaller in order
to make use of the entire drive.

Windows NT permits a maximum of 4 par-
titions per drive.

To partition and format a SCSI drive:

1 From the Start menu, choose Programs >
Administrative Tools > Disk Administrator.

2 When Disk Administrator opens, select
Disk Configuration from the View menu.

3 Disk Administrator lists all SCSI drives at-
tached to your system. Your system boot
drive will be identified as Disk 0, and any
audio drives will be listed as Disk 1, Disk 2,
and so on. Unformatted volumes are indi-
cated by diagonal lines. The amount of Free
Space available on each volume is also indi-
cated.

Z Disk Administrator

Pattiion Teok Wiew Options Help
=[B
= Disk 0 C: E: F
IBM_PRELOAC  |PROTOOLS A SYSTEME
FAT FAT Fal
8631 MB 2000 ME 4024 MB 2667 MB
=l Disk 1
SETBME  [ETEME
CD-ROMO | D:
W Frimany partition
|Partition [4024 B |[E- [PROTOOLS &

Disk Administrator



4 Right-click on the rectangle representing
the hard drive that you wish to parti-
tion/format.

5 In the menu that appears, choose Create.

6 Enter the desired size of the selected
drive’s primary partition. Maximum parti-
tion size for the FAT16 file system is

4095 MB. If you wish to create the largest
possible partition, enter 4095. Click OK.

7 A dialog box appears asking you to con-
firm this operation. Click Yes. You will now
see a 4095 MB unformatted volume.

8 Right-click on the unformatted volume,
and in the menu that appears, choose
Commit Changes Now.

9 Click Yes to save changes, then click OK.

10 Right-click mouse on the unformatted
volume. In the menu that appears, choose
Format.

11 In the Format dialog, choose FAT from
the File System pull-down menu.

12 In the Volume Label field, enter a name
for the volume. Names must adhere to
DOS/Windows NT naming conventions.

13 Check (enable) the Quick Format box,
then click Start.

14 Click OK in the dialog. Disk Administra-
tor formats the disk.

15 When the format operation is complete,
click OK.

16 Click Close to close the Format window.

17 The partitioned, formatted volume now
appears in the Disk Administrator window,
with a drive letter and labels indicating its
name, file system, and size.

18 If you wish to create additional parti-
tions on the drive (space permitting), or if
you wish to partition and format other

SCSI drives connected to your computer,
repeat the above process as necessary. Oth-
erwise, exit Disk Administrator.

O After formatting the largest blocks of a
drive, a block of free space will often remain
which may only be a few hundred megabytes in
size. You can choose to format this space or
leave it unformatted. One advantage to leaving
small blocks unformatted is that it will prevent
inadvertent Disk Allocation to a partition that
is too small to be practical for audio recording.

Optimizing Windows SCSI
Drives

To obtain optimum audio recording perfor-
mance, Digidesign recommends that you
enable the Read Cache and Write Cache
settings on all SCSI hard drives used for au-
dio recording.

To do this you must use a utility such as
Adaptec’s EZ SCSI application (version 4.0
or later), which is included with most
Adaptec SCSI accelerators and computers
equipped with on-board SCSI ports utiliz-
ing the Adaptec SCSI chip set.

To use EZ SCSI to enable Read/Write
Caches:

1 Install EZ SCSI on your computer.
2 Launch SCSI Explorer.
3 Click the Disk Cache tab.

4 From the SCSI Device List, select the au-
dio drive whose read/write caches you
want to enable.

5 In the Write Cache tab, click the Enable
Write Cache button. (This may already be
enabled.)
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6 In the Read Cache tab, click the Enable
Read Cache button. (This may already be
enabled.)

7 Repeat the above steps as necessary for
other audio drives in your system.

8 When you have finished, exit SCSI Ex-
plorer and restart your computer.

Using Macintosh Drives on
Windows Systems

For compatibility with Macintosh-based
systems, Pro Tools for Windows NT lets
you record and play back sessions directly
from a Macintosh-formatted (HFS) drive
connected to a Windows NT system. This
functionality requires that all Macintosh
session and audio files be stored on Macin-
tosh-formatted drives.

To mount HFS drives on a Windows NT sys-
tem, you must use the MacOpener™ soft-
ware utility. A demo version of
MacOpener is installed with Pro Tools.

Installing the MacOpener Utility

To use Macintosh-formatted HFS drives,
you will need to install the MacOpener
software utility. The MacOpener installer
was placed on your hard drive when you
installed Pro Tools, in the following loca-
tion:

Program Files\Digidesign\Pro Tools Utili-
ties\MacOpener Demo
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To Install MacOpener:

1 Locate the Setup.exe file in the above lo-
cation and double-click it to launch the in-
staller.

2 Follow the on-screen instructions to in-
stall MacOpener.

3 After installation is complete, restart
your computer.

Enabling the MacOpener Driver

By default, MacOpener is enabled and its
default settings allow you to mount HFS
drives. You do not need to change these
settings. If you later need to enable the
MacOpener Driver, do the following:

To enable the MacOpener Driver:

1 From the Start menu, choose Programs >
MacOpener > MacOpener Driver Prefer-
ences.

2 Under Driver Settings, select Enable
MacOpener Driver.

3 Under Compatibility Mode, select Mac-
PC Compatibility Mode, and click OK.

Mounting HFS Drives

The first time you attach an HFS-formatted
drive to a Windows NT system, you must
use Disk Administrator to put a disk signa-
ture on the drive. This signature allows a
Windows NT system to recognize the HFS
drive and assign a drive letter. It will not in-
terfere with normal operation when you re-
connect the drive to a Macintosh com-
puter.

To create a disk signature:

1 From the Start Menu, choose Programs >
Administrative Tools > Disk Administrator.



2 If there is no NT signature on the new
disk, the Disk Administrator will ask if you
want to create one for the new drive. Click
OK to create the signature.

To mount an HFS drive:

If the MacOpener utility is installed and
enabled, no additional steps are required to
mount HES drives. They will appear as nor-
mal system drives after you connect them
and restart your computer.

Formatting and Maintaining HFS
Drives

While it is possible to use MacOpener to
format HFS drives from a Windows NT ma-
chine, this can yield unpredictable results.
If you need to format an HFS drive, connect
it to a Macintosh computer and use a Mac-
intosh formatting utility.

Don’t Use Windows NT Disk Utility
Software on HFS Drives

Disk utility software for the Windows NT
platform (such as Norton Utilities for Win-
dows) should not be used on HFS drives.
These utilities do not recognize HFS-for-
matted drives and may try to reformat
them. This could cause format errors on
the HFS drive and result in data loss.

If you need to perform disk maintenance
on an HFS-formatted drive, connect the
drive to a Macintosh computer and use a
Macintosh utility.

Using The Mt. Digi Utility
(Pro Tools lll/Macintosh Systems Only)

Pro Tools III systems includes a utility
called Mt. Digi™. This Control Panel device
is useful for enabling fast SCSI transfer
mode and adjusting the time that your sys-
tem takes to scan and locate hard drives
connected to the Disk I/O SCSI bus.

After you have installed Pro Tools software,
refer to the information given here to learn
how to use Mt. Digi to improve hard drive-
related system performance.

Enabling Fast SCSI Transfers

Mt. Digi allows you to enable what is called
fast SCSI mode. This mode, also known as
synchronous transfer mode, is supported
by SCSI 2 or newer hard drives. It allows
faster transfer of data to and from your
hard drive via the SCSI bus on Pro Tools III
Disk I/O cards.

Since this can help improve system perfor-
mance, Digidesign recommends that you
enable this option. If, however, you have
an older SCSI I-type drive, or are having
disk reliability problems, you may wish to
leave this option off.

0 Use an active terminator if you plan to use
Fast SCSI mode.

To activate Fast SCSI transfers:

1 From the Apple menu, choose the
Mt. Digi Control Panel. (You must have
first run the Pro Tools Software Installer.)

2 Select Enable Fast SCSI.
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3 Restart your computer for the change to
take effect.

4 If a drive does not function properly
when fast SCSI transfers are enabled, dese-
lect the Enable Fast SCSI option and restart
your computer.

SO=——— ML. Digi™

Card Slot = Ow00

Mt DigiMers 1.3

Scan Time (ms) = 1000 @

I Type “endor Product Rewv

@

[

B| Dizk | SEAGATE ST34301N o017

B[ Dizk | SEAGATE ST34301N o017

HE| cru MCR S3ICT10 1
fresean]  Limown

digidesign

%Enable Fazt SCSI

Mt. Digi Control Panel

Adjusting Scan Times
(Pro Tools lll Systems Only)

The Mt. Digi Control Panel also allows you
to provide additional time for your system
to recognize drives that may be slow to
mount, or alternatively, increase the load
speed of the DigiSystem INIT by decreasing
drive scan time. You can do this by adjust-
ing the Scan Time setting, which controls
the time your system spends scanning for
hard drives. The default scan time is 1000
ms.

To adjust drive mount scan time with
Mt. Digi:

1 From the Apple menu, choose the
Mt. Digi Control Panel.
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2 Using the up/down arrows, adjust the
optimum scan time for your drive.

3 Each time you change the values, click
the Mount button. Mt. Digi will scan the
Disk I/O SCSI bus and attempt to mount
your drive. If you have set a time that is too
short, the drive may not respond quickly
enough and fail to appear on the Desktop.

4 If a drive fails to mount, increase the scan
time until it does.

Mounting Drives with Mt. Digi

A third use for the Mt. Digi Control Panel is
to mount hard drives turned on after start-
ing your computer without having to re-
start your system.

To mount hard drives with Mt. Digi:

1 From the Apple menu, choose the
Mt. Digi Control Panel.

2 Click the re-scan button to scan the SCSI
devices currently connected to your sys-
tem. You can toggle between multiple

Pro Tools Disk I/O cards by clicking Card
Slot =.

3 Click Mount to mount the drives that ap-
pear on the chosen SCSI bus.

A Though the Mount button allows you to
mount drives without restarting your system,
they will not be in Fast SCSI mode even if the
Enable Fast SCSI option has been enabled.
You must restart your computer to enable Fast
SCSI mode.



chapter 4

Connecting Your Studio

This chapter explains how to connect

Pro Tools to a mixer, amplification system,
digital recorders, and SMPTE synchroniza-
tion devices.

The information is organized according to
the type of interface or Pro Tools configu-
ration you have. Instructions are provided
for:

* 888/241/0

* 882/201/0

e 1622 1/0

O If you have an ADAT Bridge 1/0 Interface, re-
fer to the ADAT Bridge 1/0 User’s Guide for de-
tails on connecting it to your studio.

Choosing an Output Mode

Before you make any connections, you
should determine how you want to use
Pro Tools with the other elements in your
studio, such as your mixing console and
outboard effects devices.

Pro Tools software provides you with two
different output modes, direct outputs and
stereo mix outputs. In Stereo mix outputs
mode, each audio track or channel can be
panned between any pair of outputs on the
Audio Interface (1-2, 3-4, 5-6, or 7-8). In

direct outputs mode, each track/channel is
routed to a discrete output on the Audio In-
terface. In this mode, no panning controls
are available.

Stereo Mix Outputs Mode

Stereo mix outputs mode is useful for ste-
reo final mixes of all the elements of your
Pro Tools Sessions. Using stereo mix out-
puts mode with more than one pair of ste-
reo outputs can be very useful in post pro-
duction for creating stem and M&E (music
and effects) mixes, where it’s convenient to
have audio elements in stereo pairs.

Direct Outputs Mode

Direct outputs mode is useful for laying
back elements to multitrack tape or feeding
audio to individual channels of a mixing
console.

O To select an output mode in Pro Tools, see
“Choosing an Output Mode” on page 54.
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The 888/24 1/0 Interface

This section explains each of the connec-
tors and indicators on the front and back
panels of the 888/24 I/O Interface, how
they are used, and offers suggestions for
connecting the 888/24 1/0 to your studio.

888/24 1/0 Front Panel

The 888/24 1/O has the following front
panel indicators, moving from left to right:

585 indk
’ i — 1 I — i
20000000 90000000 o

DT

Front panel of the 888/24 1/0

o

1. Power

This switch applies power to the 888/24.
The “I” position is on. The “O” position is
off.

2. Sync Mode

The Sync Mode LEDs indicate which sam-
ple rate clock reference is currently used by
the analog-to-digital converters (ADCs)
and the digital-to-analog converters
(DAC:s).

Internal This is the 888/24 I/O standard set-
ting. In this mode, the 888/24 I/O sample
rate is generated by its internal crystal oscil-
lator (whose frequency is determined by
the Sample Rate setting in the Session
Setup window). Internal mode should be
active whenever the 888/24 1/0 is not syn-
chronized to an external clock source.
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Digital This setting indicates that an
AES/EBU or S/PDIF word clock signal is cur-
rently the source for the 888/24 1/O sample
rate. This is the setting to use for inputting
material from DAT recorders or other digi-
tal devices.

To use the 888/24 1/O digital inputs and
outputs as effects sends and returns to dig-
ital effects devices, you should set the
888/24 1/0O to Internal Sync Mode. You
should then set the digital effects device to
accept an external digital clock (from the
888/24 1/0) so it synchronizes itself to

Pro Tools.

The 888/24 I/O can only synchronize to
and receive word clock lock on channels
1-2 of its digital inputs. To synchronize
your system to an external digital clock
source, it must be connected to digital in-
puts 1-2 of the 888/24 1/0. In an expanded
Pro Tools system, the system clock is car-
ried by the Audio Interface connected to
the first Pro Tools card in your system. This
Audio Interface will act as the master inter-
face in your system. All other Audio Inter-
faces will be slaved to it.

A Because some digital audio devices do not
output proper clock when they are not playing
back, leaving the 888/24 1/0 in Digital Sync
Mode may cause Pro Tools audio playback
quality to suffer, or play back at the wrong
pitch. If you are using digital 1/0, reset the
Sync Mode from Digital to Internal after input-
ting material.

Slave This LED is lit when the 888/24 1/O
sample rate is synchronized to another
Digidesign Audio Interface or synchroniza-
tion peripheral. In this mode, the sample
rate of the slave interface is derived from



the frequency of the incoming master
clock signal present at the Slave Clock
(256x) port.

The 888/24 I/O automatically switches to
this mode when a Slave Clock Out signal
from another Digidesign Interface, Univer-
sal Slave Driver, Video Slave Driver, or
SMPTE Slave Driver is connected to the
888/24 1/0O Slave Clock In port.

In expanded Pro Tools systems, the Super
Clock output of the master Audio Interface
locks all other interfaces together with
sample accuracy, keeping all signals phase-
synchronous.

0O When slaving to a Digidesign Universal
Slave Driver, Video Slave Driver, or SMPTE
Slave Driver, set the clock source to Internal.
The Audio Interface will automatically switch to
Slave mode when it detects the 256x input
clock.

3. Sample Rate and 1-2 Format
Indicators

These LEDs indicate the sample rate of the
888/24 1/0O internal crystal oscillator and
the digital format (AES/EBU or S/PDIF) of
the audio input signal to channels 1 and 2.

The choice of digital format for these two
channels is made in the Session Setup win-
dow or Hardware Setup dialog. Digital in-
put pairs 3-4, 5-6, and 7-8 of the

888/24 1/O are always AES/EBU. Sample
Rate is set in the Session Setup window or
Hardware dialog in Pro Tools.

The 888/24 1I/O provides the following
sample rates:

48 kHz This is a standard sampling rate of
many professional audio devices. It is rec-
ommended for use with devices that can-
not receive digital transfers at 44.1 kHz.

44.1 kHz This is the compact disc standard
sampling rate and the Pro Tools default
sample rate. To avoid the need for sample
rate conversion, you should use this rate
when you are recording material that will
ultimately be published on a compact disc.

A When you are using an external digital
source such as a DAT recorder, the front panel
of the 888/24 1/0 indicates only the internal
oscillator sample rate, not that of the external
digital source.

4. Level Meters

The 888/24 1/0 level meters monitor the
channel outputs of Pro Tools. Input levels
are monitored on-screen in the Pro Tools
software.

The 888/24 1/0O is factory calibrated so that
a meter reading of —18 dB corresponds to
the 888/24 1/O nominal operating level
(which can be set to either +4 dBu or

-10 dBV). If you sent the output to an ana-
log device with a VU meter, this would cor-
respond to “0O VU” on the VU meter.

The red LED indicators on the Audio Inter-
face indicate both full-code (highest level
before clipping) and clipping of Pro Tools
output signals. The on-screen meters in
Pro Tools software indicate clipping when
at least three consecutive full-code samples
follow each other.
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5. Input Level Trims

The 888/24 I/O analog inputs are factory
calibrated at a —18 dB nominal level, refer-
enced to a full code signal. This means that
at the nominal reference input level (either
+4 dBu or -10 dBV), you have 18 dB of
headroom before clipping. The input level
trim pots allow adjustment of the

888/24 1/0 input levels to match the oper-
ating level of your external equipment. Ad-
justments can be made with a Phillips
screwdriver.

6. Output Level Trims

The 888/24 1/O analog outputs are factory
calibrated at a —18 dB nominal level, refer-
enced to a full code signal. This means that
at the nominal reference output level (ei-
ther +4 dBu or-10 dBV), you have 18 dB of
headroom before clipping. The output
level trim pots allow adjustment of the
888/24 1/O output levels to match the op-
erating level of your external equipment.
Adjustments can be made with a Phillips
screwdriver.

To calibrate the input and output levels of
the 888/24 1/O to match your mixing con-
sole or other devices in your studio, use
Calibration Mode and the Signal Generator
Plug-In in Pro Tools.

O Instructions for calibrating the 888/24 1/0
appear in Appendix B of this Guide.
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888/24 1/0 Back Panel

The 888/24 I/O has the following back
panel connectors, moving from left to
right:

FEER
lele]lclclclcllclelicle]

LTI

Back panel of the 888/24 1/0

1. Analog Audio Outputs

These are balanced male XLR connectors
for analog audio output connections. All
eight output channels are continuously ac-
tive. The 888/24 1/O analog outputs feature
24-bit digital-to-analog converters.

2. Analog Audio Inputs

These are balanced female XLR connectors
for analog audio input connections. The
888/24 1/0 analog inputs feature 24-bit an-
alog-to-digital converters. Because input
channels 1-8 of the 888/24 I/O are soft-
ware selectable in pairs between analog or
digital format, analog input to a channel
pair is disabled when digital input format is
chosen for that channel.

The 888/24 1I/O analog audio connectors
are balanced XLRs with pin 2 wired hot,
(or “+"); pin 3 cold, (or “~”); and pin 1
ground.



3. AES/EBU Digital Outputs 1-8

The 888/24 I/O AES/EBU output jacks are
balanced, three conductor, XLR connectors
which output a 24-bit digital data stream.
Output is continuously active on both the
AES/EBU and S/PDIF jacks even when the
888/24 1/0 input selector is set to analog.

4. AES/EBU Digital Inputs 1-8

The AES/EBU digital format is used in
many professional digital audio devices, in-
cluding some DAT recorders. The Inter-
face’s AES/EBU input jacks are balanced,
three conductor, XLR connectors which ac-
cept a full 24-bit digital data stream.

For AES/EBU connections, 110-ohm cables
are highly recommended for use in profes-
sional installations. For best results, cable
lengths should not exceed 30 meters.

Input channels 1-8 of the 888/24 /O are
software-selectable in pairs between analog
or digital format. Digital input to a channel
pair is disabled when analog input format
is chosen for that channel in the Hardware
Setup dialog. Input to AES/EBU input chan-
nels 1-2 is disabled when S/PDIF digital for-
mat is chosen for these inputs in the

Pro Tools Session Setup window.

5. 50-pin Interface Connector

This 50-pin Computer connector is used to
connect the 888/24 I/O to a MIX card, d24
audio card, Disk I/O card, or a DSP Farm
card. The necessary cable is supplied with
your Audio Interface. If you plan to con-
nect two 888/24 1/0O Interfaces to a MIX
card or d24 card, a 16-channel peripheral
cable adapter is necessary. (This cable is
available from your Digidesign dealer.)

6. S/PDIF Digital Input/Output

The Sony Phillips Digital Interface Format
(S/PDIF) is used in many professional and
consumer CD players and DAT recorders.
The 888/24 I/O S/PDIF in/out jacks are un-
balanced 2-conductor phono (RCA) jacks
which utilize a full 24-bit digital data
stream. To avoid RF interference, use 75-
ohm coaxial cable for S/PDIF transfers and
keep the cable length to a maximum of 10
meters.

Because input channels 1-2 of the

888/24 1/0 are software selectable between
analog or digital format, input to these two
digital channels is disabled when analog
input is chosen or when AES/EBU digital
format is chosen in the Pro Tools Session
Setup window. Output is continuously ac-
tive on both the AES/EBU and S/PDIF out-
put jacks, regardless of which digital input
format is selected for channels 1-2. To
avoid RF interference, use 75-ohm coaxial
cable for S/PDIF transfers and do not ex-
ceed a cable length of 10 meters.

7/9. Slave Clock In/Out

The Slave Clock Out jack is a standard BNC
type connector that outputs a 256 times
sample rate Super Clock signal for slaving
and synchronizing multiple Digidesign In-
terfaces and synchronization peripherals
together.

When the 888/24 1/O Sync Mode is set to
Internal, connecting a valid Slave Clock
Out signal to this port will cause the
888/24 1/0 to automatically switch to Slave
mode. When the 888/24 1/O is the master
interface or the first interface in a chain,
Digital sync mode overrides the Slave
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Clock input, and an incoming Slave Clock
Out signal will not switch the 888/24 1/0
to Slave mode.

Because crucial timing data is passed over
these ports, you should use high-quality,
75-ohm RG-59 cables for making connec-
tions, and keep total cable length to less
than 3 meters between interfaces.

8. Power Input

This connector accepts a standard AC
power cable. The Interface is auto power-
selecting (100V to 240V) and will automat-
ically work with a standard modular cable
to connect to AC power receptacles in any
country.
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Changing Operating Levels
of Individual 888/24 1/0
Channels

The 888/24 1/0 is factory set to +4 dBu op-
erating levels for input and output. How-
ever, the 888/24 1/0 allows you to individ-
ually switch any of its analog inputs or
outputs to either a +4 dBu or -10 dBV oper-
ating level by moving internal jumpers on
its circuit board.

output level

adjustment switches
+4 dBu or -10 dBV

input level
adjustment switches
+4 dBu or -10 dBV

The location of input and output level switches inside
the 888/24 1/0

To change the operating level of an input
channel:

1 Turn off your computer and the
888/24 1/0.

2 With a Phillips screwdriver, remove the
screws from the top of the 888/24 1/0.

3 Using the 1/16-inch hex wrench in-
cluded with the 888/24 1/0O, carefully re-
move the front four panel screws as noted
on the bag containing the hex wrench.

4 Lift the top off of the 888/24 1/0.



5 Inside the 888/24 I/O chassis, next to
each of the channel input trims, there is a
jumper switch with a removable cap. Lo-
cate the jumper switch for the channel you
wish to modify. Gently lift the cap off the
3-pronged connector. Place it in the posi-
tion corresponding to the operating level
that you desire. For +4 dBu levels, it should
be placed over the rear two prongs. For
—-10 dBV levels, it should be placed over the
front two prongs.

6 After you have made the desired changes,
replace the top of the 888/24 I/0O.

7 Replace the four front panel screws using
the hex wrench.

8 Replace the top screws with a Phillips
screwdriver.

pull off jumper o |-

place jumper
in this position

to set input
to +4 dBu level

Setting the input level jumper switches

place jumper
in this position

to set input
to -10 dBV level

To change the operating level of an output
channel:

1 Turn off your computer and the
888/24 1/0.

2 Using the 1/16-inch hex wrench in-
cluded with the 888/24 I/O, carefully re-
move the front four panel screws as noted
on the bag containing the hex wrench.

3 With a Phillips screwdriver, remove the

screws from the top of the 888/24 I/O and
lift the top off of the 888/24 1/O.

4 To find the channel output switches, de-
tach the front part of the ribbon cable at
the right side of the chassis. To do this, grip
both sides of the black connector and gen-
tly pull up.

5 With the ribbon cable out of the way
you'll see eight 3-pronged jumper switches,
each with a removable cap. Locate the
switch for the channel you wish to modify.

Setting the output level jumper switches

6 Gently lift the cap off of the jumper
switch. Place it in the position correspond-
ing to the operating level that you desire.
For +4 dBu levels, it should be placed over
the left two prongs. For -10 dBV levels, it
should be placed over the right two prongs.

7 After you have made the desired changes,
reconnect the ribbon cable and put the top
back on the 888/24 I/0O.

8 Replace the four front panel screws using
the hex wrench.

9 Replace the top screws with a Phillips
screwdriver.
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Making Signal Connections

to the 888/241/0

Depending on how you plan to use the

888/24 1/0, the way you connect it to your

studio will vary.

Choosing between +4 dBu and

=10 dBV operation modes
The 888/24 1/O can be set to operate at

+4 dBu or -10 dBV input and output levels.
It is important that you determine which
line level mode is appropriate for your stu-

dio. In +4 dBu operating mode, the

888/24 1/0 is a 24-bit digital audio device

capable of producing audio signals at or
near +26 dBu.

Check the owner’s manual for your mixer,
power amplifier or effects processor to see if
it can handle this load. If it cannot, con-
sider setting the 888/24 I/O to operate at

—10 dBV line levels.

Consider the following when connecting a

mixer:

o If your mixer cannot handle more than

1.5V (RMS) inputs at +4 dBu, then you

should set the 888/24 1/O to run at-10 dBV

line level.

o If your mixer can handle up to 8.5V

(RMS) inputs, or has pads or attenuators on
its inputs, then you can use the +4 dBu set-

ting on the 888/24 1/0.

Most manuals contain device input specifi-
cations, including whether or not there are
pads or attenuators. Consult the manufac-
turer of your mixer or power amplifier for

further information.
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Setting Up Your Studio

The following diagram illustrates a typical
studio setup, with the 888/24 I/O con-
nected to a mixing console, effects and
other equipment.

nnnnn

Digital Effects Devices
(set to external sync)

A typical studio configuration

The 888/24 1/O analog audio connectors
are balanced XLRs with pin 2 wired hot
(or “+”), pin 3 cold (or “~”), and pin 1
ground.

If you are connecting a balanced system,
pin 1 and shield should be connected at
the input only (not at the output). This will
prevent ground loops between the shield
and pin 1 conductor.

If you are connecting an unbalanced signal
to the 888/24 I/O inputs or outputs, con-
nect only pin 2 to the “+” signal, and pins
1 and 3 to ground at all inputs only.



Using the 888/24 1/0
Interface as Stand-Alone
Audio Converter

The 888/24 1/O can be used apart from
Pro Tools as a stand-alone 8-channel, 24-
bit, analog-to-digital or digital-to-analog
converter.

Before you use the 888/24 1/0 in stand-
alone mode:

1 Turn off the 888/24 1/0.

2 Do not turn on your computer while the
888/24 1/0 is in stand-alone mode. If you
do, the 888/24 1/O will stop functioning in
stand-alone mode.

To use the 888/24 1/0 as a stand alone A/D
converter:

1 Turn off any digital devices that may
send a word clock signal to the 888/24 1/O
channel 1-2 digital input ports.

2 Turn on the 888/24 I/O. The 888/24 1/0O
searches briefly for a word clock signal on
channels 1-2 of its digital input ports.

3 If the 888/24 1/O does not detect word
clock, it functions as a stand-alone A/D
converter using its internal clock. In this
mode you will use analog inputs 1-8 and
AES/EBU outputs 1-8.

0O The default sample rate of the 888/24 1/0
in stand alone A/D mode is 44.1 kHz.To
change this default setting to 48 kHz, you
must open the 888/24 I/0 and manually re-
set it by moving an internal jumper switch. In-
structions for doing this are provided in the
888/24 1/0 Installation Guide.

To use the 888/24 1/0 as a stand alone D/A
converter:

1 Make sure that a digital device providing
a word clock signal is connected to
AES/EBU inputs 1-2 of the 888/24 I/O and
turned on.

2 Turn on the 888/24 1/O. The 888/24 1/O
will search for a valid word clock or a word
clock signal on channels 1-2 of its digital
input ports.

3 When a valid word clock lock is recog-
nized, the 888/24 1/O will enter digital
sync mode and function as a stand-alone
D/A converter using AES/EBU inputs 1-8
and analog outputs 1-8.

The 888/24 1/O D/A sample rate is deter-
mined by the sample rate it detects on
channels 1-2 of its AES/EBU inputs.

0O The 888/24 1/0 defaults to listening to a
digital word clock signal on channels 1-2 of its
AES/EBU digital input ports. To use a S/PDIF
device as your source of word clock, you must
reset this default by opening the 888/24 1/0
and moving an internal jumper switch. Instruc-
tions for doing this are provided in the
888/24 1/0 Installation Guide. That Guide
also provides instructions for changing other
stand-alone mode default parameters such as
sample rate and DAC muting.

To return the 888/24 1/0 to Pro Tools-based
operation:

0 Turn on your computer.

o If your computer is on, launch Pro Tools.
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The 882/20 1/0 Interface

This section explains all of the connectors
and indicators on the front and back pan-
els of the 882/20 I/O Interface, how they
are used, and offers suggestions for con-
necting the 882/20 I/O to your studio.

882/20 1/0 Interface Front
Panel

The 882/20 I/O has the following front
panel indicators, moving from left to right:

Front panel of the Digidesign 882/20 I/0

1. Power

This switch applies power to the 882/20.
The “I” position is on. The “O” position is
off.

2. Sync Mode

The Sync Mode LEDs indicate which sam-
ple rate clock reference is currently used by
the analog-to-digital converters (ADCs)
and the digital-to-analog converters
(DAC:s).

Internal This is the 882/20 I/O standard set-
ting. In this mode, the 882/20 I/O sample
rate is generated by its internal crystal oscil-
lator (whose frequency is determined by
the Sample Rate setting in the Session
Setup window). Internal mode should be
active whenever the 882/20 1/0O is not syn-
chronized to an external clock source.
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Digital This setting indicates that a S/PDIF
word clock signal is the source for the
882/20 1/O sample rate. This is the setting
you would use for inputting material from
DAT machines or other S/PDIF digital de-
vices.

To use the 882/20 I/O digital input and
output as an effects send and return to a
digital effects device, you should set the
882/20 1/0O to Internal Sync Mode. You
should then set the digital effects device to
accept an external digital clock (from the
882/20 1/0O) so it synchronizes with

Pro Tools.

In an expanded system, the system clock is

carried by the Audio Interface connected to
the first Pro Tools card in your system. This

Audio Interface will act as the master inter-
face in your system, and all other Audio In-
terfaces will be slaved to it. Only the master
interface allows you to set the Sync Mode.

Slaved interfaces do not allow this parame-
ter selection.

A Because some digital audio devices do not
output proper clock when they are not playing
back, leaving the 882/20 I/0 in Digital Sync
Mode may cause Pro Tools audio playback
quality to suffer, or to play back at the wrong
pitch. If you are using digital 1/0, reset the
Sync Mode from Digital to Internal after input-
ting material.

Slave This LED is lit when the 882/20 I/O
sample rate is synchronized to another
Digidesign Audio Interface or synchroniza-
tion peripheral. In this mode, the sample
rate of the slave interface is derived from
the frequency of the incoming master
clock signal present at the Slave Clock
(256x) port. The 882/20 I/O automatically



switches to this mode when a Slave Clock
Out signal from another Digidesign Inter-
face, Universal Slave Driver, Video Slave
Driver, or SMPTE Slave Driver is connected
to its Slave Clock In port.

In expanded Pro Tools systems, the Super
Clock output of the master Audio Interface
locks all other interfaces together with
sample accuracy, keeping all signals phase-
synchronous.

0O When slaving to a Digidesign Universal
Slave Driver, Video Slave Driver, or SMPTE
Slave Driver, set the clock source to Internal.
The Audio Interface will automatically switch to
Slave mode when it detects the 256x input
clock.

3. Ch 1-2 Input

This LED indicates the format (analog or
digital) of the audio input signal to chan-
nels 1 and 2. In Pro Tools, you choose ana-
log or digital input for these two channels
in the Session Setup window. Input chan-
nels 3 through 8 of the 882/20 I/O are al-
ways analog.

4. Sample Rate

These LEDs display the current sample rate
of the 882/20 1/0O internal crystal oscillator,
which can be either 44.1 kHz or 48 kHz. In
Pro Tools, this is set in the Session Setup
window.

The 882/20 I/O provides the following
sample rates:

48 kHz This is a standard sampling rate of
many professional audio devices. It is rec-
ommended for use with devices that can-
not receive digital transfers at 44.1 kHz.

44.1 kHz This is the compact disc standard
sampling rate and the Pro Tools default
sample rate. To avoid the need for sample
rate conversion, you should use this rate
when you are recording material that will
ultimately be published on a compact disc.

A When you are using an external digital
source such as a DAT recorder, the front panel
of the 882/20 1/0 indicates only the internal
oscillator sample rate, not that of the external
digital source.

5. Signal Present LEDs

These LEDs indicate whether signal is
present (above the level of -30 dB) at a
given channel’s output. These LEDs indi-
cate the presence of channel output sig-
nals, not input signals. Input signals are
monitored on-screen in the Pro Tools soft-
ware. The LEDs do not indicate clipping.
Clipping is indicated by the on-screen
meters in Pro Tools software.
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882/20 1/0 Back Panel

The 882/20 I/O has the following back
panel connectors, moving from left to
right:

56666666 @@@@@@@@ Lo ‘@ wa, G
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Back panel of the Digidesign 882/20 1/0

1. Analog Audio Inputs

These are balanced, 1/4-inch TRS jacks for

analog audio input connections. The

882/20 I/O analog inputs feature 20-bit an-

alog-to-digital converters.

Input operating levels are switchable be-
tween +4 dBu and -10 dBV operation. Un-

balanced connections are supported

through the use of standard 1/4-inch TRS

mono phone plugs.

Because input channels 1-2 of the

882/20 1/0 are software selectable between
analog or S/PDIF digital format, input to

these two analog channels is disabled

when S/PDIF digital input format is chosen

in the Pro Tools Hardware Setup dialog.

The 882/20 I/O analog inputs are factory

calibrated at a —14 dB nominal level, refer-
enced to a full code signal. This means that
at the nominal reference input level (either

+4 dBu or -10 dBV), you have 14 dB of
headroom before clipping.
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2. Analog Audio Outputs

These are balanced, 1/4-inch TRS jacks for
analog audio output connections. The
882/20 1/O analog outputs feature 20-bit
digital-to-analog converters.

All eight output channels are continuously
active. Output operating levels are switch-
able between +4 dBu and -10 dBV opera-
tion. Unbalanced connections are sup-
ported through the use of standard 1/4-
inch TRS mono phone plugs.

The 882/20 I/O analog outputs are factory
calibrated at a —14 dB nominal level, refer-
enced to a full code signal. This means that
at the nominal reference output level (ei-
ther +4 dBu or-10 dBV), you have 14 dB of
headroom before clipping.

3. Slave Clock In/Out

The Slave Clock Out jack is a standard BNC
type connector that outputs a 256x audio
sample rate master Super Clock signal for
slaving and synchronizing multiple
Digidesign Interfaces and synchronization
peripherals together.

The Slave Clock In jack is a standard BNC
type connector designed to receive a Slave
Clock Out signal from another Digidesign
Interface, a Universal Slave Driver™, Video
Slave Driver™, or SMPTE Slave Driver™ for
synchronizing multiple Digidesign Inter-
faces and synchronization peripherals to-
gether.



When the 882/20 I/O Sync Mode is set to
Internal, connecting a valid Slave Clock
Out signal to this port will cause the
882/20 I/0O to automatically switch to Slave
mode. When the 882/20 I/O is the master
interface or the first interface in a chain,
Digital sync mode overrides the Slave
Clock input, and an incoming Slave Clock
Out signal will not switch the 882/20 to
Slave mode.

Because crucial timing data is passed over
these ports, you should use high-quality,
75-ohm RG-59 cables for making connec-
tions, and keep total cable length to less
than 3 meters between interfaces.

4. S/PDIF Digital Input/Output

The Sony Phillips Digital Interface Format
(S/PDIF) is used in many professional and
consumer CD players and DAT recorders.
The 882/20 1I/O S/PDIF jacks are unbal-
anced, two-conductor, phono (RCA) jacks.
Because input channels 1-2 of the

882/20 1/0O are software selectable between
analog or digital format, input to these two
digital channels is disabled when analog
input is chosen in the Hardware Setup dia-
log in Pro Tools. Output is continuously ac-
tive on the S/PDIF output jack, even if the
882/20 I/O input selector is set to Analog in
the Hardware Setup dialog. To avoid RF in-
terference, use 75-ohm coaxial cable for
S/PDIF transfers and do not exceed a cable
length of 10 meters.

5. 50-pin Interface Connector

This 50-pin connector is used to connect
the 882/20 I/O to a MIX card, d24,

Disk I/O, or DSP Farm card. The necessary
cable is supplied with your Audio Interface.
If you plan to connect two 882/20 /O In-
terfaces to a MIX card or d24 card, a 16-
channel peripheral cable adapter is neces-
sary. (This cable is available from your
Digidesign dealer.)

6. Power Input

This connector accepts a standard AC
power cable. The Interface is auto power se-
lecting (100 V-240 V), and will automati-
cally work with a standard modular cable
to connect to AC power receptacles in any
country.
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Making Signal Connections
to the 882/201/0

Depending on how you plan to use the
882/20 1/0O, the way you connect it to your
studio will vary.

Choosing between +4 dBu and
=10 dBV operation modes

The 882/20 I/O can be set to operate at

+4 dBu or -10 dBV input and output levels.
It is important that you determine which
line level mode is appropriate for your stu-
dio. In +4 dBu operating mode, the
882/20 1/0O is a 20-bit digital audio device
capable of producing audio signals at or
near +18 dBu. Check the owner’s manual
for your mixer, power amplifier or effects
processor to see if it can handle this load. If
it cannot, consider setting the 882/20 I/O
to operate at —10 dBV line levels.

Consider the following when connecting a
mixer:

0 If your mixer cannot handle more than
1.5V (RMS) inputs at +4 dBu, then you
should set the 882/20 I/O to operate at
-10 dBV line level.

o If your mixer can handle up to 8.5V
(RMS) inputs, or has pads or attenuators on
its inputs, then you can use the +4 dBu set-
ting on the 882/20 I/0O.

Most manuals contain device input specifi-
cations, including whether or not there are
pads or attenuators. Consult the manufac-
turer of your mixer or power amplifier for
further information.
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Setting Up Your Studio

The following diagrams provide general
suggestions for connecting studio gear to
your system. The first illustrates a studio
setup with the 882/20 I/O connected to a
mixing console, with effects and other gear
routed into the console as well. The second
diagram shows a setup without a mixer,
where effects and monitoring gear are con-
nected directly to the 882/20 1/0.
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Using the 882/201/0
Interface as Stand-Alone
Audio Converter

The 882/20 I/O can be used apart from
Pro Tools as a stand-alone 2-channel, 20-
bit, analog-to-digital or digital-to-analog
converter.

A The 882/20 I/0 always operates at
—10 dBV when in stand-alone mode.

Before you use the 882/20 1/0 in stand-
alone mode:

1 Turn off the 882/20 1/O.

2 Do not turn on your computer while the
882/20 1/0 is in stand-alone mode. If you
do, the 882/20 I/O will stop functioning in
stand-alone mode.

To use the 882/20 1/0 as a stand alone A/D
converter:

1 Turn off any digital devices that may
send a word clock signal to the 882/20 I/O
S/PDIF digital input.

2 Turn on the 882/20 1/O. The 882/20 1I/O

searches briefly for a word clock signal on
channels 1-2 of its digital input ports.

3 If the 882/20 I/O does not detect word
clock, it functions as a stand-alone A/D
converter using its internal clock. In this
mode you will use analog inputs 1-2 and
the S/PDIF output.

A In stand-alone mode, the 882/20 only oper-
ates at a 44.1kHz sample rate. If you wish to
convert analog signals into 48kHz digital au-
dio, you must launch Pro Tools (or any other
software which supports the 882/20 1/0) to
change the default sample rate.

To use the 882/20 1/0 as a stand alone D/A
converter:

1 Make sure that a digital device providing
a word clock signal is connected to the
S/PDIF input of the 882/20 I/O and that
the device is powered on.

2 Turn on the 882/20 I/O. The 882/20 1/0O
will search for a valid word clock on its
S/PDIF input.

3 When a valid word clock lock is recog-
nized, the 882/20 I/O will enter digital
sync mode and function as a stand-alone
D/A converter using the S/PDIF input and
analog outputs 1-2.

The 882/20 I/O sample rate is determined
by the sample rate that it detects on its
S/PDIF input.

To return the 882/20 1/0 to Pro Tools-based
operation:

0 Turn on your computer.
o If your computer is on, launch Pro Tools.
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The 1622 1/0 Interface

This section explains the connectors and
indicators on the front and back panels of
the 1622 1/O Interface, how they are used,
and offers suggestions for connecting the

1622 1/0 to your studio.

1622 1/0 Front Panel

The 1622 1/0 has the following front panel

indicators, moving from left to right:

[ B0 - FTRT
»e
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Front panel of the Digidesign 1622 I/0

1. Power

This switch applies power to the 1622 I/0.
The “I” position is on. The “O” position is

off.

2. Sync Mode

The Sync Mode LEDs indicate which sam-
ple rate clock reference is currently used by

the analog-to-digital converters (ADCs)
and the digital-to-analog converters
(DAC:).

Internal This is the 1622 I/O standard set-

ting. In this mode, the 1622 I/O sample

rate is generated by its internal crystal oscil-
lator (whose frequency is determined by

the Sample Rate setting in the Session

Setup window). Internal mode should be
active whenever the 1622 1/0 is not syn-

chronized to an external clock source.
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Digital This setting indicates that a S/PDIF
word clock signal is the source for the
1622 1/0 sample rate. This is the setting to
use for inputting material from DAT ma-
chines or other S/PDIF digital devices.

To use the 1622 1/0O digital input and out-
put as an effects send and return to a digital
effects device, set the 1622 I/O to Internal
Sync Mode. Set the digital effects device to
accept an external digital clock (from the
1622 1/0) so it synchronizes with

Pro Tools.

In expanded Pro Tools systems, the Super
Clock output of the master Audio Interface
locks all other interfaces together with
sample accuracy, keeping all signals phase-
synchronous.

A Because some digital audio devices do not
output proper clock when they are not playing
back, leaving the 1622 1/0 in Digital Sync
Mode may cause Pro Tools audio playback
quality to suffer, or to play back at the wrong
pitch. If you are using digital 1/0, reset the
Sync Mode from Digital to Internal after input-
ting material.

Slave This LED is lit when the 1622 I/O is
synchronized to another Digidesign Audio
Interface or synchronization peripheral. In
this mode, the sample rate of the slave in-
terface is derived from the frequency of the
incoming master clock signal present at the
Slave Clock (256x) port. If the Sync Mode is
set to Internal, connecting a Slave Clock
Out signal from another Digidesign Inter-
face or synchronization peripheral to the
1622 1/0 Slave Clock In port will automat-
ically switch it to Slave mode.



In expanded Pro Tools systems, the Super
Clock output of the master Audio Interface
locks all other interfaces together with
sample accuracy, keeping all signals phase-
synchronous.

O When slaving to a Digidesign Universal
Slave Driver, Video Slave Driver, or SMPTE
Slave Driver, set the clock source to Internal.
The Audio Interface will automatically switch to
Slave mode when it detects the 256x input
clock.

3. Ch 1-2 Input

This LED indicates the format (analog or
digital) of the audio input signal to chan-
nels 1-2. In Pro Tools, you choose analog
or digital input for these two channels in
the Session Setup window or the Hardware
Setup dialog. Input channels 3 through 16
of the 1622 I/O are always analog.

4. Sample Rate

These LEDs display the current sample rate
of the 1622 I/O internal crystal oscillator,
which can be either 44.1 kHz or 48 kHz. In
Pro Tools, this is set in the Session Setup
window or in the Hardware Setup dialog.

The 1622 1/O provides the following sam-
ple rates:

48 kHz This is a standard sampling rate of
many professional audio devices. It is rec-
ommended for use with devices that can-
not receive digital transfers at 44.1 kHz.

44.1 kHz This is the compact disc standard
sampling rate and the Pro Tools default
sample rate. To avoid the need for sample
rate conversion, you should use this rate

when you are recording material that will
ultimately be published on a compact disc.

A When you are using an external digital
source such as a DAT recorder, the front panel
of the 1622 1/0 indicates only the internal os-
cillator sample rate, not that of the external
digital source.

5. Input Meters

These LEDs indicate whether signal is
present at a given channel’s input. Segment
1 (green) indicates —20.0 dB. Segment 2
(vellow) indicates —-3.0 dB. Segment 3 (red)
indicates 0.1 dB.

6. Output Meters

These LEDs indicate whether signal is
present at one of the two outputs. Segment
1 (green) indicates —20.0 dB. Segment 2
(yellow) indicates —-3.0 dB. Segment 3 (red)
indicates —0.1 dB.

7. Channel 15-16 Direct Inputs

These are balanced, 1/4-inch TRS jacks for
convenient front panel audio input con-
nections.

Inputs can be individually calibrated from
+4 dBu to-10 dBV line levels and higher in
2 dB gain steps, using the Other Options
dialog (choose Setups > Hardware and click
Other Options). This allows the 1622 1/O
to accommodate any standard line-level in-
put, including synthesizers, samplers and
effects devices. Unbalanced connections
are supported through the use of standard
1/4-inch TRS mono phone plugs.
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1622 1/0 Back Panel

The 1622 1/O has the following back panel

connectors, moving from left to right:

|c666060606666656 i
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Back panel of the Digidesign 1622 I/0

1. Analog Audio Inputs 1-14

These are balanced, 1/4-inch TRS jacks for

analog audio input connections.

Inputs can be individually calibrated from
+4 dBu to-10 dBV line levels and higher in
2 dB gain steps, using the Other Options
dialog (choose Setups > Hardware and click
Other Options). This allows the 1622 1/O
to accommodate any standard, line-level

input, including synthesizers, samplers

and effects devices. Unbalanced connec-

tions are supported through the use of

standard 1/4-inch TRS mono phone plugs.
The 1622 I/O analog inputs are factory cal-

ibrated at a —-14 dB nominal level, refer-

enced to a full code signal. This means you
can have up to 14 dB of headroom before

clipping, depending on the input levels
you set in the Other Options dialog.

Because input channels 1-2 of the 1622 I/O
are software-selectable between analog or
S/PDIF digital format, input to these two
analog channels is disabled when S/PDIF

digital input format is chosen in the
Pro Tools Hardware Setup dialog.

42 Pro Tools TDM Hardware Installation Guide

2. Analog Audio Outputs L-R

These are balanced, 1/4-inch TRS jacks for
analog audio output connections. They
carry Pro Tools main output channels 1-2.
The analog outputs feature 24-bit digital-
to-analog converters. Both output chan-
nels are continuously active. Output oper-
ating levels are switchable between +4 dBu
and -10 dBV operation.

Unbalanced connections are supported
through the use of standard 1/4-inch TRS
mono phone plugs.

The 1622 /O analog outputs are factory
calibrated at a —14 dB nominal level, refer-
enced to a full code signal. This means that
at the nominal reference output level (ei-
ther +4 dBu or-10 dBV), you have 14 dB of
headroom before clipping.

3. Slave Clock In/Out

The Slave Clock Out jack is a standard BNC
type connector that outputs a 256x audio

sample rate master Super Clock signal for

slaving and synchronizing multiple Audio
Interfaces and synchronization peripherals
together.

When the 1622 I/O Sync Mode is set to In-
ternal, connecting a valid Slave Clock sig-
nal to the Slave Clock In port will cause the
1622 I/O to automatically switch to Slave
mode. When the 1622 I/O is the master in-
terface or the first interface in a chain, Dig-
ital sync mode overrides the Slave Clock in-
put, and an incoming Slave Clock Out
signal will not switch the 1622 I/O to Slave
mode.

Because crucial timing data is passed over
these ports, you should use high-quality,
75-ohm RG-59 cables for making connec-



tions, and keep total cable length to less
than 3 meters between interfaces.

4. S/PDIF Digital Input/Output

The Sony Phillips Digital Interface Format
(S/PDIF) is used in many professional and
consumer CD players and DAT recorders.
The 1622 1/O S/PDIF jacks are 24-bit capa-
ble, unbalanced, two-conductor, phono
(RCA) jacks.

Because input channels 1-2 of the 1622 I/O
are software selectable between analog or
digital format, input to these two digital
channels is disabled when analog input is
chosen in the Hardware Setup dialog in
Pro Tools.

Output is continuously active on the
S/PDIF output jack, even if the 1622 I/O in-
put selector is set to analog in the Hardware
Setup dialog. To avoid RF interference, use
75-ohm coaxial cable for S/PDIF transfers
and do not exceed a cable length of 10
meters.

5. 60-pin Interface Connector

This 60-pin connector is used to connect
the 1622 1/O to a MIX or d24 card. The ap-
propriate interface cable is supplied with
the 1622 I/0.

6. Power Input

This connector accepts a standard AC
power cable. The 1622 1/0O is auto power se-
lecting (100 V-240 V), and will automati-
cally work with a standard modular cable
to connect to AC power receptacles in any
country.

Making Signal Connections
to the 1622 1/0 Interface

Depending on how you plan to use the
1622 1/0, the way you connect it to your
studio will vary.

Adjusting 1622 1/0 Gain Levels

The 1622 1I/O input levels are adjustable
through the Pro Tools software to accom-
modate a variety of equipment output lev-
els. For optimum fidelity and signal-to-
noise performance, you should adjust these
inputs according to the devices that you
connect to them.

After you have set up, configured, and
launched Pro Tools, refer to the instruc-
tions below for adjusting input gain levels
for the 1622 I/0O.

O For best signal-to-noise performance, set
the 1622 1/0 input gain to +4 dBu when re-
cording devices that provide this output level.

To adjust input level gain on the 1622 1/0:

1 Connect the instrument or device to the
1622 1/0.

2 In Pro Tools, choose Setups > Hardware.
3 Click Other Options.

4 Set the input trim slider to match the
output level of the connected instrument.
(Refer to the manufacturer’s documenta-
tion for details.) If you do not know the
output level of the device, use the default
input trim level, then fine tune the input
level gain using the procedure below.

5 Select the desired output gain level,
+4 dBu or =10 dBV, and click Done.
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To fine tune the input level gain:

1 Create an auxiliary input track. This can
be either mono or stereo depending on the
device you are monitoring.

2 Set the track input to the 1622 I/O input
channel you just set in the Other Options
dialog.

3 Play the instrument at maximum vol-
ume, sending a steady signal to the

1622 1/0. (You will not be able to hear the
input signal while adjusting your levels in
this dialog, but you can see the levels on
the input meters of the 1622 1/0.)

4 Note where the instrument output signal
registers on the on-screen meters in
Pro Tools.

5 In the Other Options dialog, adjust the
channel input trim slider to increase or de-
crease gain until you are able to achieve
maximum signal level without clipping.

6 Repeat as necessary for other instru-
ments/inputs.

7 Click Store, then Done.

8 Click OK when you have finished.

O Input trim level, output line level, and sam-
ple rate settings are stored in non-volatile
memory so that the 1622 1/0 will retain them
when used in stand-alone mode.

A/D Input Reference Level:

-10dBV Line Level
-8 dBV Instrument Level

wsag- |- f-f-[-0-0-0-0-0-0-0-0-0-0-0-0- +4 dBu Line Level

102 204 5 51 8 28z s MDEEIE
Ouput Line Level: S/PDIF Compatability:
[ans Q-10dB |—om-3n ® other

The Other Options dialog
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Setting Up Your Studio

The diagrams below provide suggestions
for connecting studio gear to your system.
The first illustrates a studio setup with the
1622 I/O connected to a mixing console,
with effects and other gear routed into the
console as well. The second diagram illus-
trates a setup without a mixer, where ef-
fects processors and monitoring gear are
connected directly to the 1622 I/0O.

S/PDIF Digital Input/Output
To DAT Recorder

DAT Recorder
Analog

Effects Devices

Audio
Analog Outputs 1-2

Audio Inputs 1-16
(15-16 on front panel)

Channel
Outputs 1-16 Tape Returns
or Inputs 1-2

AARAAARRAN

O

©

O|

©

)

Power Amp
and Speakers

© 600 50000 aa
© 000 50000 aa
© 000 50600 aa

=@ 600 5006060 aa

Connected to Console

A typical studio configuration with a mixer

O O
olo
I ! Mic Preamp, 00
k5 k5 Direct Box, Synth, etc.
v U Power Amp
=) HE=) and Speakers
Analog
Audio S/PDIF Digital Input/Output
Outputs 1-2 <7 To DAT Recorder

i I [
20
DAT Recorder

A typical studio configuration without a mixer



Using the 1622 1/0
Interface as Stand-Alone
Audio Converter

The 1622 1I/O can be used apart from

Pro Tools as a stand-alone 2-channel, 20-
bit analog-to-digital, or 24-bit digital-to-an-
alog converter.

Input and output levels are determined by
the settings last saved by clicking the Store
button in the Other Options dialog (choose
Setups > Hardware and click Other Op-
tions).

A If no input level settings are stored, input
levels default to +4 dBu and output levels de-
fault to —-10 dBV.

There are no panning controls in stand-
alone mode. Odd-numbered channels are
hard-panned left and even-numbered
channels hard-panned right. Mono instru-
ments will play out of output L or R, but
not both. Stereo instruments will play out
of both outputs L and R. Output gain must
be controlled directly from connected in-
struments.

Before you use the 1622 1/0 in stand-alone
mode:

1 Turn off the 1622 I/0.

2 Do not turn on your computer while the
1622 1/0O is in stand-alone mode. If you do,
the 1622 I/O will stop operating in stand-
alone mode.

To use the 1622 1/0 as a stand-alone A/D
converter:

1 Turn off any digital devices that may
send a word clock signal to the 1622 I/O
S/PDIF digital input.

2 Turn on the 1622 I/O. The 1622 I/O
searches briefly for a word clock signal on
channels 1-2 of its digital input ports.

3 If the 1622 I/O does not detect word
clock, it functions as a stand-alone A/D
converter using its internal clock. In this
mode you will use analog inputs 1-16 and
the S/PDIF output.

To use the 1622 1/0 as a stand-alone 24-bit
D/A converter:

1 Make sure that a digital device providing
a word clock signal is connected to the
S/PDIF input of the 1622 I/O and that the
device is powered on.

2 Turn on the 1622 I/O. The 1622 I/O will
search for a valid word clock on its S/PDIF
input port.

3 When a valid word clock lock is recog-
nized, the 1622 I/O will enter digital sync
mode and function as a stand-alone D/A
converter using the S/PDIF input and ana-
log outputs 1-2.

To return the 1622 1/0 to Pro Tools-based
operation:

0 Turn on your computer.

o If your computer is on, launch Pro Tools.
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Connecting Equipment with
Digital Audio Ins and Outs

Because the 888/24 1/0, 882/20 1/0,

1622 1/0, and ADAT Bridge 1/0O feature dig-
ital inputs and outputs, Pro Tools allows
you to digitally record to or from a digital
device such as a DAT recorder. The

888/24 1I/O and ADAT Bridge 1/O provide
both AES/EBU and S/PDIF digital audio in-
put and output. The 882/20 I/O and

1622 1/0O provide S/PDIF digital audio in-
put and output.

If you plan to use a DAT player, CD re-
corder, or other digital input and output
device with your Pro Tools system, be sure
the external device supports either the
AES/EBU or S/PDIF format. Your interface’s
AES/EBU inputs and outputs should only
be connected to another AES/EBU device.
Likewise, its S/PDIF inputs and outputs
should only be connected to another
S/PDIF device.

To connect your Pro Tools system to a DAT
recorder:

1 Connect the digital output of the Audio
Interface to the digital input of the DAT
deck. Audio channels 1 and 2 will be sent
out of these outputs.

2 Connect the digital output of the DAT to
the digital input of the Audio Interface.
The DAT recorder will be routed to

Pro Tools inputs 1 and 2.
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Connecting Effects Units

The 888/24 1/0O, 882/201/0, 1622 1/0, and
ADAT Bridge 1/O Audio Interfaces allow
you to connect effects units to your system
by using any analog (or digital) inputs/out-
puts as auxiliary inputs/outputs for effects
sends and returns. Once an effects unit is
attached this way, you can send a variable
amount of a track’s output to the effects
unit using a send fader in Pro Tools.

Five separate send controls on each

Pro Tools track allow you to route audio to
any of the available outputs connected to
your system or through any of the 32-inter-
nal busses in the Pro Tools TDM Mixer.
Outputs can be returned to mono or stereo
auxiliary inputs for automated mixing or
processing.

When you are using an effect in this send-
type of configuration, make sure the unit’s
internal mix or balance between direct (un-
processed) and wet (effected) signal is set so
that only the processed signal is returned
to Pro Tools. On most effect units, a bal-
ance setting of 100% (completely wet) is
the appropriate setting.

If you've been using an effects unit in an
instrument setup, such as a guitar effects
rack, you'll probably find the balance to be
below 50%. If the unit has separate dry and
effect level knobs, turn dry level control
off. If you don’t do this, the dry, unproc-
essed signal will be present in an effect’s
output along with the desired processed
sound, and you’ll have trouble accurately
controlling the effect balance in your final
mix.



Connecting Effects Units Digitally

To use your Audio Interface’s inputs and
outputs as effects sends & returns to a digi-
tal effects device, set your interface to Inter-
nal Sync mode (unless it is already synchro-
nized to an external clock source such as a
DAT deck). You should then set your digital
effects devices to accept an external digital
clock so that they will synchronize them-
selves to Pro Tools. In the Pro Tools Hard-
ware Setup dialog, set the input of the
channel pair to which you have connected
the digital effects device to Digital, and set
the Sync Mode to Internal.

MIDI Connections

By adding a Macintosh or Windows-com-
patible MIDI Interface to your system, you
can take advantage of all the MIDI features
of Pro Tools, including recording and edit-
ing MIDI tracks, syncing to MIDI Time
Code or MIDI beat clock (this requires an
appropriate MIDI interface) and the use of
MIDI Controllers.

O For information on configuring a MIDI con-
trol surface for use with Pro Tools, see the
Pro Tools MIDI Controllers Guide.

Macintosh

0 Blue & White Macintosh G3 computers re-
quire additional hardware to allow MIDI con-
nections. Refer to Chapter 1 of this guide for
more information.

To connect MIDI devices to your system:

1 Connect the MIDI interface to your com-
puter according to the MIDI interface’s
documentation.

A On older (pre-Blue & White G3) Power Mac-
intosh computers, connect the MIDI interface
to the modem port. MIDI timing data output
through the modem port is more accurate than
that output through the printer port.

2 Install any MIDI driver software required
by the MIDI interface. (Once you have in-
stalled your MIDI Interface hardware and
software, confirm that it is working prop-
erly using the procedure given in the inter-
face’s documentation.)

3 Connect the MIDI OUT of your MIDI de-
vice or controller to the MIDI IN of your
MIDI interface.

4 Connect the MIDI IN of your MIDI de-
vice or controller to the MIDI OUT of your
MIDI interface.

O See the Pro Tools Software Installation
Guide for information on configuring OMS
(Open Music System) software, which is re-
quired on Macintosh systems.

Chapter 4: Connecting Your Studio

47



Windows

To connect a MIDI device or MIDI controller

to your system:

1 If your MIDI interface has an accompa-
nying MIDI card, install the card into your

computer according to the card’s docu-
mentation.

2 Connect the MIDI interface to your com-

puter according to the MIDI interface’s
documentation.

3 Install any MIDI driver software required
by the MIDI card/interface. (Once you have
installed your MIDI Interface hardware and
software, confirm that it is working prop-

erly using the procedure given in the inter-

face documentation.)

4 Connect the MIDI OUT of your MIDI de-
vice or controller to the MIDI IN of your

MIDI interface.

5 Connect the MIDI IN of your MIDI de-
vice or controller to the MIDI OUT of your

MIDI interface.
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Connecting SMPTE
Synchronization Devices

If you intend to synchronize Pro Tools to
external devices with SMPTE using MIDI
Time Code, your system must be con-
nected properly. This section provides
setup suggestions for synchronizing

Pro Tools to audio or video tape. For details
on SMPTE and synchronization, see the
Pro Tools Reference Guide.

Pro Tools and Synchronization

Pro Tools supports a type of SMPTE syn-
chronization known as SMPTE Trigger
through the use of SMPTE-to-MIDI Time
Code converters. This type of synchroniza-
tion allows Pro Tools to chase and start (or
stop) playback and recording while slaved
to other systems. With SMPTE Trigger
alone, once playback or recording starts,
there is no further synchronization, and
Pro Tools will play back at a rate deter-
mined by the internal clock of the Audio
Interface or selected external clock source.

For fairly short pieces of audio program
material, SMPTE Trigger is acceptable, espe-
cially if the sync master has a fairly stable
transport or is resolved to house sync or a
black burst generator. In this case, the mas-
ter transport and Pro Tools will probably
not drift very far apart in such a short pe-
riod of time.

On the other hand, if the audio piece is sev-
eral minutes long, or if the sync master has
an unstable transport (as in the case of a
low quality recording deck striped with
SMPTE, for example), SMPTE Trigger alone
is probably not an acceptable solution,



Trigger Sync for Audio Post Applications
(recommended for short duration audio regions)

[E—

Video Tape Recorder

SMPTE * OR + VITC Video out
LTC and VITC to MIDI Time
Code Convertor
MIDI Time
Code out

MIDI Interface

* to computer

Composite
Video out

=

50 .———h
RGB Monitor Computer Computer

Monitor

A synchronization setup using SMPTE Trigger alone

since the two systems may drift apart no-
ticeably over the duration of the source
material.

A better alternative is to use Digidesign’s
Universal Slave Driver.

The Digidesign Universal Slave
Driver

The Universal Slave Driver (USD) is a multi-
purpose synchronization peripheral that
provides virtually all of the functions and
connections needed to achieve synchroni-
zation to a variety of devices.

The USD allows synchronization of

Pro Tools to Linear Time Code (LTC), exter-
nal video black burst, or word clock signal.
It supports all major industry-standard
clocks and formats and can also act as a
stand-alone MIDI Time Code (MTC) or
VITC reader/generator.

In addition, the Universal Slave Driver of-
fers extremely fast lockup, near-sample ac-
curate synchronization, and an exception-
ally low-jitter clock. These features provide
professional performance and maximum
audio fidelity under a wide range of syn-
chronization conditions.
LTC or VITC-locked Sync for music/audio applications

with Digidesign’s Universal Slave Driver
(for resolving to LTC or VITC)

1 oooomo
Video Tape Recorder
SMPTE * OR * VITC Video out

g[g @ ‘fé 9@@[8 g \Lg @l Digidesign Universal Slave Driver

serial output
direct to
MIX or d24 card's
DigiSerial port

Composite
Video out

[ele) o
RGB Monitor

—=

Computer
Monitor

Computer

A synchronization setup using a USD
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Making Sure Your System Is Working

After you have installed Pro Tools software
and hardware, you should confirm that

your system is working properly. To do this
you'll install and play the demo session in-
cluded on the Pro Tools Installer CD-ROM.

% DigiTest =

I il card H1} Test Card Tiest e
I bis card H2 Test Card st G
I DSP Fam #1 Test Card Test Cerd

I Testard TestCard

HEHHE

0 & o O o

Test et

O If you haven't already installed Pro Tools = o
software, do so now. See the Pro Tools Soft- Ep—
ware Installation Guide for instructions.

HEHE

Cancel Test

DigiTest (Windows)

3 Next to each card designation is a small

- - checkbox. Click the checkbox and the
conflgu"ng ExPanded front panel meters of the Audio Interface

Pro Tools Systems connected to that card will light up.

(Windows Systems Only) 4 Repeat the previous step for each
Pro Tools card in your system. As you do,

write down the name of the card and the
type of interface connected to that card.
This is necessary to configure each of the
Audio Interfaces.

Before you can test an expanded Windows-
based Pro Tools system, you must identify
which Audio Interface is connected to
which Pro Tools card. The DigiTest utility
included with Pro Tools allows you to do

this. For example:

e MIX card #1 = 888/24 1/0O #1
To use DigiTest: e MIX card #2 = 888/24 1/O #2
1 Start your computer. e DSP Farm #1 = 888/24 I/O #3

2 From the Start menu, choose Programs > 5 The Audio Interface connected to the
Digidesign > Pro Tools > DigiTest. DigiTest card that appears as card #1 in the DigiTest
opens, listing each of the Pro Tools cards in window will function as the clock master
your system. for your Pro Tools system. If you have more
than one Audio Interface, connect the one
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you want to use as your clock master to
Pro Tools card #1.

A You can switch an Audio Interface to a differ-
ent Pro Tools card without shutting down your
computer, but you must turn off the Audio In-
terface before doing so.

6 After properly identifying all cards/Audio
Interfaces, click Test All Slots to run a brief
test to confirm that your cards are operat-
ing properly.

7 When all cards pass, exit DigiTest and re-
start your computer.

O If DigiTest reports an error message when
testing your cards, write it down before calling
your local Digidesign Technical Support repre-
sentative.

Starting Up Your System

Before you test your system, you must turn
on all of your system components in a spe-
cific order.

Start your Pro Tools System in this order:

1 Turn on your external hard drives. Wait
approximately ten seconds for them to
come up to speed.

2 Turn on your Pro Tools Audio Interfaces.
Wait at least ten seconds for them to initial-
ize.

3 Turn on your computer. Or, if it is already
on, restart it.

O See the Release Notes & Documentation
folder within the Pro Tools folder for late-break-
ing information.
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Installing the Demo
Session

Next you will install the demo session in-
cluded on the Pro Tools Installer CD-ROM.

Macintosh

To install the demo session:

1 Insert the Pro Tools Installer disc in your
CD-ROM drive.

2 Double-click the file “Install Pro Tools
Demo Session.”

3 Select “Pro Tools SoundCheck.” This is
the session used for testing your system.
The other demo sessions demonstrate more
capabilities of Pro Tools. Since they are not
used for testing purposes, installation is op-
tional.

4 Choose a drive on which to install the
demo session. If you have a Pro Tools III
system, choose a drive that is connected to
the Disk I/O card.

5 Click Install. When installation is com-
plete, click OK to return to the Finder.

Windows

To install the demo session:

1 Insert the Pro Tools Installer disc in your
CD-ROM drive.

2 Locate and double-click the “Pro Tools
Demo Installer” folder.

3 Double-click the file “Install Pro Tools
Demo Session.”

4 Select “Pro Tools SoundCheck.” This is
the session used for testing your system.
The other demo sessions demonstrate more



capabilities of Pro Tools. Since they are not
used for testing purposes, installation is op-
tional.

5 Select the desired items and click Next.
6 Click the Browse button to choose a SCSI
drive that is connected to your system and

formatted for use as an audio drive. Install
the demo session there.

7 When installation is complete, click Fin-
ish to exit the Demo Installer.

Opening the Demo Session

Now you will open the demo session and
begin playback to hear Pro Tools in action.

To open the demo session:

1 Locate and open the demo session folder.
2 Double-click the file, “Pro Tools Sound-
Check.”

3 A dialog appears prompting you to use
the Hardware dialog to configure your sys-
tem. Click OK.

Hardware Setup
r Interface Options:

Card:

MIH Card #1 v
800/24 1/0™ +~
44180 v

AES/EBU
Analog +

Interface Port:
Interface:
Sample Rate:
Sunc Mode:
Digital Format:

Ch 1-2 Input:

[ Other Options }

The Hardware dialog

[Recalihrale Inpuls]

Configuring Pro Tools for the
First Time

The first time you open Pro Tools, you
must use the Hardware dialog to configure
the parameters for each Pro Tools card and
Audio Interface in your system.

If you have a system with multiple cards
and/or Audio Interfaces, you must config-
ure each by selecting the appropriate items
from the pop-up menus in this dialog.

You must select the card, identify the inter-
face connected to it, then set the parame-
ters for that interface—repeating this for
each card/interface in your system.

A Some parameters explained below do not
apply to all Pro Tools configurations.

To configure Pro Tools:

1 From the Card pop-up, select the Digide-
sign card type.

2 From the Interface port pop-up, choose
the port to which your Audio Interface is
connected (port A or port B).

Choose port A if only one Audio Interface

is connected to the card. If two Audio Inter-
faces are connected to your card, follow the
steps below for each port/interface.

O The Interface port pop-up does not appear
for Pro Tools Il systems.

3 From the Interface pop-up, choose the
Audio Interface connected to the card you
selected in the previous step.

4 From the Sample Rate pop-up, select the
desired sample rate for the current card and
interface (the sample rate of the demo ses-
sion is 44100 Hz).
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5 From the Sync Mode pop-up, select the
appropriate sync mode on the currently se-
lected interface (Internal or Digital). In
most cases you will use Internal. Digital is
used primarily for inputting data from DAT
or other digital sources.

6 From the Digital Format pop-up, select
the desired digital format of Channels 1-2
of the currently selected interface
(AES/EBU or S/PDIF).

7 From the Ch 1-2 Input pop-up, select the
input format of Channels 1-2 of the cur-
rently selected interface (Analog or Digi-
tal).

8 Click Recalibrate Inputs to recalibrate the
analog-to-digital convertors of the Audio
Interface and remove any DC offset that
may have built up in them. (For an expla-
nation of DC offset, see the DigiRack Plug-
Ins Guide.)

9 Click Other Options for additional con-
figuration options specific to the Audio In-
terface. These include:

0 Setting the input format (analog or digi-
tal) of each pair of input channels on a
888/24 1/0O

0 Configuring the level sensitivity and
peak hold settings for the output level
meters on the front panel of the 888/24 1/O

o Selecting S/PDIF compatibility with Tas-
cam DA30 DAT recorders

A To record to or from a Tascam® DA30 DAT

recorder you must set S/PDIF compatibility to
“Tascam.” To record to or from a non-Tascam
DA30 DAT recorder, set S/PDIF compatibility to
“Other.”

0 Enabling or disabling DAC Muting
(mutes the 888/24 I/O digital-to-analog
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convertors when its output level falls below
a certain threshold, to reduce noise)

0 Setting the input and output levels of a
1622 1/0

10 Configure the Other Options parame-
ters as desired and click Done.

11 Click OK to close the Hardware Setup
dialog. The demo session opens.

To play the demo session:

1 Adjust the volume control on your mon-
itoring system so that it is set relatively low.
You can adjust levels as the demo begins to
play.

2 Press the Spacebar on your keyboard to
begin playback. To stop playback, press the
Space bar again.

Welcome to Pro Tools!
O If you weren’t able to play the demo ses-

sion, see Appendix D of the Pro Tools Refer-
ence Guide for troubleshooting tips.

Choosing an Output Mode

Before you start your first session, configure
your system’s output mode. Pro Tools has
two different output modes, direct outputs
mode and stereo mix outputs mode. These
allow you to set Pro Tools channel outputs
to match your studio setup.

Direct Outputs Mode

In direct outputs mode, track outputs are
routed to a single Audio Interface output:
1,2,3,4,5,6, 7,8, and so on. Panning con-
trols are not available in this mode.



Stereo Mix Outputs Mode

In stereo mix outputs mode, track outputs
are routed to a pair of Audio Interface out-
puts: 1-2, 3-4, 5-6, 7-8, and so on. Each
track has controls for panning between the
selected output pair.

To choose an output mode:
1 From the Setups menu, choose Prefer-
ences and click the Operation button.

2 Choose the desired operating mode and
click Done.

Pro Tools Preferences

Operation
Display

Oper ation

[ Timetine Insertion Fallows Playback
EEd\t Insertion Follows Serub/Shuttle

Editing

Automation
[ Latch Selo Buttons

[ Latch Record Enable Buttons

[ Support Background Record Applications
[ Link Mix And Edit Group Enables

[ Audie During Fast Forward /Rewind

[ use F11 Key for Wait For Note

Processing

Compatibility

Humeric Keypad Mode

() Classic

@ Transport

() Shutile
Output Optiens

) @) Stereo Mix Outputs
() Direct Outputs

Online Options
@) Record Online At Time Code (or ADAT) Lock
() Record Online At Insertion Selection

Open Ended Record Allocation
@) Use all Available Space

) Lirnit Ta roinutes

futo Region Fade In/ut Length:_0 | msec
Galibration Reference Level: - 0 |dB

Choosing an output mode
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Determining Slot Order On Macintosh

Computers

To propertly install Pro Tools cards in Mac-
intosh computers you must first determine
the slot numbering for your particular
model. The DigiTest application, located in
the Digidesign Utilities folder, allows you
to do this.

A DigiTest is included on the Pro Tools In-
staller CD-ROM and installed with Pro Tools. If
you haven’t already run the Pro Tools Installer,
do so now.

To see slot numbering for your computer:

1 Open DigiTest.

2 From the SlotPictures menu, choose your
Macintosh model. A drawing of the com-

puter is shown, with its slots numerically
labeled.

3 Make a note of the slot order shown in
the illustration.

4 Quit DigiTest.
5 Shut down your computer.

6 Using the slot numbering indicated by
DigiTest, install your Pro Tools cards in the
order given in the section that follows.

Card Order Guidelines for
Each Pro Tools System

The following are card installation guide-
lines for each TDM-equipped Pro Tools sys-
tem. Install your cards in your Macintosh
in the following order, starting with the
lowest numeric slot:

O The guidelines below may include optional
cards not present in your system.

Card order for Pro Tools 24 MIX and MIXplus:
MIX Core cards

MIX Farm cards

MIX I/O cards

SampleCell II TDM cards

SCSI accelerator cards

Video capture cards

N 0O g~ WON PR

Display card for your computer monitor

Card order for Pro Tools 24:
1 Pro Tools d24 audio cards
2 DSP Farm cards

3 MIX I/O cards

4 SampleCell II TDM cards
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5 SCSI accelerator cards
6 Video capture cards
7 Display card for your computer monitor

Card order for a Pro Tools 24 system that has

been upgraded to a Pro Tools 24 MIX system:

MIX core card

d24 audio cards

DSP Farm cards

MIX I/O cards
SampleCell Il TDM cards
SCSI accelerator cards
Video capture cards

©® N O O A W N R

Display card for your computer monitor

Card order for Pro Tools lll:

1 Video capture cards or SCSI accelerator
cards

2 Disk I/O cards

3 DSP Farm cards

4 SampleCell I TDM cards

5 Display card for your computer monitor

Additional Rules for Card
Placement

For all Pro Tools systems:

¢ In systems with more than one card of
the same type, install the same card type
together in successive slots.
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¢ When combining cards of different
types, they should be installed in the fol-
lowing order:

MIX Core cards
MIX Farm cards
d24 cards

DSP Farm cards
SampleCell II cards

O o & WO N B

Do not install non-TDM cards or leave
empty slots in between TDM-equipped
cards.

For 6-slot computers with SCSI Accelerators:

e If you are using a Pro Tools 24 MIX or
Pro Tools 24 system in a 6-slot Macin-
tosh with a SCSI accelerator card or a
video capture card, the MIX card or d24
audio card must go in one of the first
(top) three PCI slots. The SCSI accelerator
or video capture card must go in one of
the last (bottom) three PCI slots. It is es-
sential that Pro Tools cards and any SCSI
accelerator or video capture cards reside
in different banks of PCI slots in 6-slot
Macintoshes.

A While SCSI accelerator cards are required
for Pro Tools 24 and Pro Tools 24 MIX sys-
tems on G3 computers, they are not sup-
ported for these Pro Tools systems on 3-slot,
non-G3 Macintosh computers.

For Systems Using an Expansion Chassis:

If you are using an Expansion Chassis, refer
to the Pro Tools Expanded System Guide in-
cluded with your Pro Tools system for in-
structions on connecting an Expansion
Chassis to your computer.



appendix b

Calibrating the 888/24 1/0

Before you use the 888/24/1/O Audio Inter-
face, you may want to calibrate its input
and output levels to the level of your mix-
ing console.

The 888/24 1/0 is factory-calibrated so that
its input operating level is set to +4 dB
nominal with 18 dB headroom nominal at
full code, unity gain, making calibration
unnecessary for most professional applica-
tions.

If you do need to recalibrate your interface
or other components of your studio, you
can use the alignment procedure described
here.

About Calibration

Calibrating levels on a digital recording de-
vice is different from calibrating levels on
an analog recording device. Unlike analog
devices, most digital devices do not have a
standard “O VU” level setting that corre-
sponds to nominal input and output levels.
Instead, with an interface such as the
888/24 1/0, the meters are calibrated in
decibels below peak (digital clipping) level.

Headroom

The concept of headroom is slightly differ-
ent for analog and digital devices.

Analog Most analog devices allow for a cer-
tain amount of headroom above 0 VU. If
you send a signal above 0 VU to an analog
recorder, you still have a margin of head-
room, and if tape saturation occurs, it does
so fairly gracefully, giving the audio a com-
pressed sound that some find desirable.

Digital Digital devices, on the other hand,
do not allow for signals that exceed the dy-
namic range of the input. When a signal
exceeds the maximum input level for a dig-
ital device, clipping occurs, causing digital
distortion, which is harsh and usually un-
desirable.

The AES Standard for Headroom

The AES (Audio Engineering Society) stan-
dard for headroom is currently —-18 dB for
nominal level in a digital audio system.
The exact value you use will be determined
by the amount of headroom available in
the rest of your system. For example, if
your mixing console has 15 dB of head-
room above nominal level, then you may
want to calibrate the 888/24 I/O to have
15 dB of headroom.
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The Calibration Process

Analog To calibrate the input level of an an-
alog device to a mixing console’s output
level, you would typically send a 1 kHz
tone at 0 VU from the console to the ana-
log deck and align the recording deck’s
meters to read 0 VU.

Digital With a digital recording device such
as the 888/24 1/0O, however, in order to al-
low for headroom, you must align a 0 VU
tone from the console to a value less than
zero on the 888/24 1/0, by exactly the
amount of headroom that you want.

For example, to have 12 dB of headroom
above 0 VU with the 888/24 1/0O, you must
align the incoming 0 VU 1kHz tone to a
level of —12 dB. For 18 dB of headroom,
you would align it to —18 dB. (Since it is as-
sumed that you are using the 888/24 1/O
with a +4 dBu console, a 0 VU signal level
coming out of the console is actually equiv-
alent to a nominal +4 dBu level signal.)

Calibrating The 888/24 1/0

To calibrate the 888/24 1/O you will put
Pro Tools software in a special operating
mode called calibration mode, then use the
Signal Generator Plug-In to generate a test
tone for alignment.

The Pro Tools Installer includes several pre-
configured calibration session templates
that cover most common calibration set-
ups. You can use these in addition to the
calibration procedure given below.
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A Turn down your monitoring system before
beginning calibration! The Signal Generator
Plug-In emits a continuous signal when in-
serted on a track.

O During calibration, set all Pro Tools track
faders to their default of O dB by Option-Shift-
clicking (Macintosh) or Alt-Shift-clicking (Win-
dows) on any fader in the session.

To calibrate the 888/24 1/0:

1 In Pro Tools, choose Setups > Preferences
and click Operations.

2 Under Output Options, select Direct Out-
puts.

3 Enter the desired Calibration Reference
Level value in dB. A level of -18 dB is typi-
cal. (It isn’t necessary to type a minus sign
here.)

4 Click Done.

5 Create a new audio track and insert the
Signal Generator Plug-In on the track.

6 Set Signal Generator’s output level. This
should be the same value you entered as
the Calibration Reference Level in step 3.

7 Set Signal Generator’s frequency to
1000 Hz.

8 Set Signal Generator’s signal waveform to
Sine.

9 Route the track’s output to Bus 1.

10 Create a mono auxiliary input track for
each 888/24 I/O output you want to cali-
brate. Set the output assignment for each of
these auxiliary inputs to its respective
888/24 1/O output.

11 Set the input of each auxiliary input
track to Bus 1.



12 Create an additional mono auxiliary in-
put track for each 888/24 I/O input you
want to calibrate. Set the input assignment
for each of these auxiliary inputs to its re-
spective 888/24 1/O input. Then set the
output of each of these auxiliary inputs to
an unused bus pair (for example bus 31-32)
so that feedback doesn’t occur when mon-
itoring main outputs 1-2.

13 Connect an external VU meter to each
of the 888/24 1/O outputs in turn. (One at a
time as you calibrate.)

14 Adjust the 888/24 I/O output level trim
pots with a Phillips screwdriver to align the
outputs to read “O VU” on the external VU
meter.

15 Connect each output of the 888/24 I/0O
directly to its input: Connect channel 1
output to channel 1 input, and so on for
each channel.

16 In Pro Tools, choose Operations > Cali-
bration Mode.

The names of all uncalibrated tracks begin
to flash. In addition, the track volume indi-
cator of each auxiliary input track receiving
an external input signal now displays the
reference level coming from the calibrated
output.

17 Adjust the 888/24 /O input level trim
pots with a Phillips screwdriver to align the
inputs to match the reference level. When
the level is properly matched, the track
name will stop flashing.

The Automatch indicator arrows on each
track show the direction of adjustment re-
quired for alignment:

0 When the incoming level is higher than
the reference level, the down arrow will ap-

pear lit (blue). In this case, trim the
888/24 1/0 input level down.

0 When the incoming level is lower than
the reference level the up arrow will appear
lit (red). In this case, trim the 888/24 1/0O
input level up.

When you have properly aligned the in-
coming peak signal levels to match the cal-
ibration reference level, both Automatch
indicator arrows will light: the up arrow red
and the down arrow blue.

18 When you have finished, choose Oper-
ations > Calibration Mode again to deselect
Calibration Mode.

Calibrating a System With Both
888/24 1/0 and 882/201/0
Audio Interfaces

The 888/24 1/0 is factory preset with 18 dB
of headroom in its +4 dB line level operat-
ing mode. The 882/20 I/O, however, is
fixed at 14 dB of headroom and its inputs
are not adjustable.

When setting up an 882/20 I/O (particu-
larly in systems using a combination of the
882/20 I/O and 888/24 1/0), make sure
that you use a headroom setting of -14 dB
for your system. This helps ensure that re-
corded audio files have the same relative
levels regardless of which interface they are
recorded with.
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Hard Drive Maintanance

Tuning Up Hard Drives

Because Pro Tools is a disk-based system,
keeping your hard drives in good operating
condition is essential.

Avoiding File Fragmentation

For maximum recording and playback effi-
ciency, data should be written to your hard
drive in a contiguous fashion—minimizing
the seek requirements to play back the
data. Unfortunately, your computer can’t
always store the sound files in this way and
must write to disk wherever it can find
space.

In multitrack recording, audio tracks are
written in discrete files, spaced evenly
across the disk. While fragmentation of in-
dividual files may be zero, the tracks may
be far enough apart that playback will still
be very seek-intensive. Also, the remaining
free space on the disk will be discontigu-
ous, increasing the likelihood of file frag-
mentation on subsequent record passes.

Increased fragmentation increases the
chance of disk errors, which can interfere
with playback of audio, and result in stut-
tering playback of audio files.

Optimizing Drives

To prevent this from happening you can
optimize your drive, which rearranges your
files into a contiguous format. Most opti-
mizing software lets you run a check on a
drive to find out the percentage of frag-
mentation. If your drive shows moderate to
heavy fragmentation, you should consider
optimizing it.

If you use your system for intensive edit-
ing, or if you frequently delete audio or
fade files from your hard drive, you may
need to optimize your drives on a weekly
basis, or even every few days, since it
doesn’t take long for even a large hard disk
to become fragmented.

Backing Up Data Before Optimizing

Since your files will be rewritten by the op-
timization process, always make a backup
copy of the data on your hard drive before
you optimize it. You should also use a hard
disk utility to find and repair any problems
before optimizing data. If there is any dam-
age to your hard drive's directories prior to
optimizing, serious data loss may result.

Windows NT includes a data backup utility
(“Backup”) that allows you to archive data
on commonly-used digital data tape de-

vices such as 4mm DDS, DLT, and Exabyte.
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CD recorders and DVD-RAM recorders also
provide a convenient and reliable way to
permanently archive audio files.

A Before optimizing or defragmenting a hard
disk on a Pro Tools Ill system, remove it from
the Disk I/0 SCSI bus and connect it to the
Macintosh SCSI bus. Always back up impor-
tant data before defragmenting the disk.

0O Windows NT does not have a built-in disk de-
fragmenting/optimizing utility. You must pur-
chase a hard drive maintenance utility such as
Norton Utilities in order to do this.

Formatting Drives

There’s more to hard drive maintenance
that just optimization. In order for a hard
drive to locate and rearrange its files, its di-
rectories must also be intact and in good
condition.

When we refer to formatting a drive, we are
really speaking of two different types of for-
matting: high-level formatting and low-
level formatting. Here is how they differ:

Low-Level (Physical) Formatting

Low-level formatting means completely
erasing the hard drive and rewriting each
sector address on the drive. In low-level
formatting, the sector and track addresses,
error-correction codes, and other details
are written on the platters of the hard drive
in the form of a magnetic pattern. A low-
level format permanently erases all data on
the drive.
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When is Low-Level Formatting Necessary?

Virtually all hard drives come pre-format-
ted from the manufacturer. Low-level for-
matting is generally unnecessary except in
rare circumstances. They are:

o If you wish to change the Block Size of
the drive. This is not recommended by
Digidesign. Digidesign systems only recog-
nize 512-byte blocks.

o If you wish to perform permanent dele-
tion of data.

0 If you wish to clean a drive that is being
migrated from one operating system to an-
other (for instance, from UNIX to Macin-
tosh).

Should you decide low-level formatting is
necessary, keep in mind that it can take up
to three hours or more (depending on the
size of the drive). Avoid power interrup-
tions and computer bus resets during the
format operation or permanent damage to
the drive could occur. In addition, leave
the drive powered on for at least 30 min-
utes prior to formatting so that the drive
has time to make any necessary thermal ad-
justments or recalibrations.

High-Level Formatting (Initialization)

High-level formatting, or initializing a drive
replaces the drive’s directory, volume parti-
tion map and drivers. Information about
the drive is created and drivers that com-
municate this information to the host CPU
are installed. The drive itself is not erased,
nor is verification performed.



When is High-Level Formatting Necessary?

It is generally necessary to initialize a hard
drive in one of the following cases:

0 If a new drive is being prepared for use
on a computer for the first time and the
drive is not already initialized.

o If a drive is being changed from one plat-
form to another. For example if you are
switching from a Windows to a Macintosh-
based system, the drive must be reinitial-
ized for the new operating system.

o If you suspect that the directories con-
taining the drive’s information have be-
come corrupted.

Partitioning Drives

Partitioning divides a physical drive into
multiple, unique volumes, almost as if you
were creating virtual hard drives. Partition-
ing is usually performed when the drive is
initialized.

A Mac OS 7.6.1 and above allows drives
larger than 4096 MB to be seen as whole vol-
umes. Drives must be initialized with a utility
that recognizes the 2 terabyte limit. Single
files cannot exceed 2048 MB in size.

Seek Times on Partitioned Drives

Seek times are actually faster on partitioned
drives (assuming that reads and writes are
performed on a single partition), since the
heads only have to seek within the parti-
tion boundaries, rather than the whole ca-
pacity of the drive.

In addition, smaller partitions perform
faster than larger partitions. However, this
comes at the expense of contiguous storage

space. When you partition a drive, you will
need to find the compromise that best suits
your performance and storage require-
ments.

A Avoid distributing audio files within a ses-
sion over different partitions on the same drive
since this will adversely affect drive perfor-
mance.

Using lomega Jaz Drives

Iomega Jaz drives provide up to 8-track re-
cording and playback of 16-bit audio files
per drive.

To use a Jaz drive:
1 Prepare the Jaz Cartridge.

Before using the Jaz drive with Pro Tools,
the cartridges must be initialized for use
with the Macintosh. Initialization must be
performed using Iomega’s Jaz Tools while
the Jaz drive is connected to the Macintosh
SCSI bus. Before initializing a cartridge, se-
lect the Verify Disk Writes option in the
Iomega Drive Options dialog.

This option provides additional data pro-
tection by ensuring that all data written to
disk is done so correctly as the data is writ-
ten. Digidesign recommends that you do
this in order to provide the highest data in-
tegrity. (The lomega Jaz Tools are included
with the Jaz Drive or they can be down-
loaded from Iomega’s web site:
www.iomega.com.)

With the Verify Disk Writes option en-
abled, Jaz drives can be used with Pro Tools
systems to record and play back up to 8
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tracks, depending on the capabilities of
your Pro Tools system. Digidesign does not
recommend disabling the Verify Disk
Writes option since data integrity may be
compromised.

2 Connect the Jaz Drive to your Pro Tools
system.

Once the Jaz cartridge has been initialized,
connect the Jaz drive to your system. For
Pro Tools 24 MIX or Pro Tools 24 systems,
connect it to your Macintosh SCSI bus or
SCSI accelerator card. For Pro Tools III sys-
tems, connect it to your Disk I/O card.

3 Mount the Jaz Cartridge.

With the Jaz drive attached to the your sys-
tem’s SCSI bus, cartridges may be inserted
and spun up prior to starting your Macin-
tosh, or they may be inserted afterwards.

On Pro Tools 111 systems, if a Jaz cartridge is
not inserted and spun up prior to starting
your Macintosh, and there are no other ac-
tive SCSI devices on the Pro Tools SCSI bus,
the DigiSystem INIT will indicate a “No
Drive” error. Simply wait for the computer
to finish starting up, then insert a cartridge.
Once the cartridge has spun up, it will ap-
pear on the desktop and be ready for use.

Enabling Fast SCSI Transfers
With Jaz Drives

Pro Tools Il Systems Only

If you have a Pro Tools III system, Digide-
sign recommends using the Jaz drive with
the Fast SCSI transfers option enabled in
the Mt. Digi utility.
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To enable Fast SCSI transfer:

1 From the Apple Menu, select Control
Panels and select Mt. Digi from the sub-
menu.

2 When Mt. Digi appears, select the Enable
Fast SCSI option.

3 Restart your computer with a Jaz car-
tridge installed and spun up for these
changes to take effect. Once fast transfers
are enabled on the Jaz drive, it will remain
in fast mode (even if you exchange car-
tridges) until you shut down, or restart
without a cartridge inserted.

Sleep Mode

Jaz drives utilize a sleep timer to spin down
cartridges after a period of inactivity in or-
der to minimize wear. The default inactiv-
ity period is 30 minutes. Pro Tools main-
tains this time period and allows Jaz to spin
down cartridges without affecting activity
on the Pro Tools SCSI bus.

Jaz users wishing to play back from or
record to a Jaz drive which is asleep will ex-
perience up to a 15 second delay as the car-
tridge spins up. Once the cartridge is ready,
normal playback or record operations will
begin.

Cartridge Ejection

In order to minimize restart times,

Pro Tools will not automatically eject car-
tridges at restart or shutdown. To eject a Jaz
cartridge after use, simply drag the car-
tridge icon to the Trash.



A Never eject cartridges while Pro Tools is run-
ning or serious data loss could occur. Always
quit the Pro Tools application before ejecting
cartridges.

Cartridge Care

To ensure the longevity of your Jaz car-
tridges, follow the manufacturer’s proce-
dures for care and handling. Do not store
cartridges on or near audio monitors or
data loss may result. We recommend that
you periodically reformat and reinitialize
Jaz cartridges in order to maintain the
highest possible performance and data in-
tegrity.

Appendix C: Hard Drive Maintanance 67



68 Pro Tools TDM Hardware Installation Guide



Numerics
1-2 Format 27
1622 1/0 Audio Interface 11
as stand-alone converter 45
back panel 42
connecting to studio 43
connections & levels 4
front panel 40
input meters 41
output meters 41
16-channel peripheral cable adapter 13
44.1 kHz 27, 35, 41
48 kHz 27, 35, 41
50-pin Interface Connector 29, 37
60-pin Interface Connector 43
882/20 1/0 Audio Interface 11, 34
+4dBu mode 32, 38
-10dBV mode 38
as stand-alone converter 39
back panel 36
connecting to studio 38
connections & levels 4
front panel 34
888/24 1/0 Audio Interface 11
as stand-alone converter 33
back panel 28
changing operating levels 30
connecting to studio 26
connections & levels 4
front panel 26

A
ADAT Bridge 1/0

connections & levels 4
Adjusting Scan Times

on Pro Tools SCSI bus 24
AES/EBU 29, 54
Analog audio

inputs 28, 36, 42
outputs 28, 36, 42

Audio Interface 53
cable 12
connecting to MIX 24 systems 11
identifying with DigiTest 52
master 12

audio playback requirements 4

B
backing up data 63

C
cable length of SCSI drives 17
Calibrating the 888/24 1/0 28, 60
Calibration Mode 28
Card order 57

Pro Tools 24 57, 58

Pro Tools Ill 58
Ch 1-2 Input 35, 41
clipping 59

clock master 11
Compatibility Information for Pro Tools 4
Configuring Expanded Pro Tools systems 51
Configuring Pro Tools 53
Connecting
Digital Recorders 46
Effects Units 46
external SCSI drive 18
SMPTE Synchronization Devices 48
studio 25

CPU requirements 1

D
d24 card 6
DAC Muting option
Hardware Setup dialog 54

Index 69



DAT recorder 54
connecting to Pro Tools 46

DC Offset 54

Demo Session 51
installing 52
playing 54

DigiSerial port 6

digital distortion 59

Digital Sync mode 26

DigiTest 51, 57

direct outputs mode 25

Disk Administrator 17

using to partition and format drives 20

Disk I/0 7, 24
disk signature 20
DSP Farm 7

E
Effects units
connecting to Pro Tools 46
EIDE drives 3
Expanded Pro Tools Systems
configuring 51
expanded systems and IDE drives 3
Expansion Chassis 5
using with Pro Tools 58

F
Fast SCSI Transfer Mode
activating 23
FAT file system 16
Formatting hard drives 16, 64
high-level 64
low-level 64

Fragmentation 63

G

G3 computer requirements 3

H
Hard Disk ToolKit™ PE 16
hard drive requirements 2
Hard drives
larger than 4 gigabytes 17
mounting 24
optimizing 63

70 Pro Tools TDM Hardware Installation Guide

Hardware Setup dialog
configuring Pro Tools with 53
DAC Muting option 54

Headroom 59

HFS Drives
formatting 23
mounting 22

High-level formatting 65

|
input gain levels
setting 43
Input Level Trims 28
Input Meters of 1622 1/0 41
Installer CD 52
Installing
Demo Session 52
Pro Tools cards 8, 9
software 5
Install-O-Rator 5
Intel PIIX IDE driver 3
Internal Sync mode 26
lomega Jaz drives 65
Cartridge Care 67
cartridge ejection 66
sleep mode 66
with Fast SCSI 66

J

Jaz drives 65

L
Level Meters 27
Low-level formatting 64

Macintosh G3 computer requirements 3

Macintosh hard drives, using 22
Macintosh sessions, playing 22
MacOpener 22
Maximum partition size 21
MIDI
connections 47
MIDI requirements 3
MIX Core Card 6
MIX Farm Card 6



Mount button 24

Mt. Digi
Control Panel 24
mounting hard drives 24

N
Norton Utilities 64

(0)
Operating levels

changing on 888/24 1/0 30
Optimizing hard drives 63
Other Options dialog 54
output gain levels

setting 44
Output level

trims 28
Output Meters of 1622 1/0 41
output mode

choosing 54

P
Partitioning
hard drives 65
maximum size 21
Power Input 30, 37, 43
Power Macintosh G3 computers 16
Power switch 40
Pro Tools 24
installing system hardware 6
system capabilities 1
Pro Tools 24 MIX
installing system hardware 5
system capabilites 1
Pro Tools Ill
core system hardware 7
system capabilities 1
Pro Tools SoundCheck session 52

R
Recalibrate Inputs button 54

S
S/PDIF 54

digital input/output 29, 37, 43
Sampling rates 27, 35, 41

SCSI accelerator cards 17, 58
SCSI bus
internal and external 16
types 16
SCSI cable length 17
SCSI termination 19
seek times of hard drives 65
setting input gain level 43
setting output gain levels 43
Signal Connections 43
to 888/24 1/0 32
Signal Generator Plug-In 28
Signal Present LEDs 35
signal-to-noise performance 43
Slave 34, 40
Slave Clock In/0Out 29, 36, 42
ports 12
Slave Sync mode 26
Sleep Mode
and lomega Jaz drives 66
Slot Order On Macintosh Computers 57
Stand-Alone mode
1622 1/0 Audio Interface 45
882/20 1/0 Audio Interface 39
888/24 1/0 Audio Interface 33
stereo mix outputs mode 25
Studio configuration
with mixer connections 38, 44
without a mixer 38, 44
studio setup
with 1622 1/0 44
with 882/20 1/0 38
with 888/24 1/0 32
Super Clock signal 29
Sync Mode 34, 40
LEDs 26
Synchronous Transfer Mode 23
system requirements 1

T

Tascam DA30 DAT recorder 54
TDM Ribbon Cable 7
Termination of SCSI drives 19

u

Universal Slave Driver 49

Index

71



w
Wiring scheme of 888/24 1/0 32

72 Pro Tools TDM Hardware Installation Guide



	Pro�Tools TDM System Requirements
	System Requirements
	CPU Requirements
	Hard Drive Requirements
	MIDI Requirements

	Additional Requirements for Blue�&�White G3 Macintosh Computers
	Pro�Tools�24 MIX/MIXplus and Pro�Tools�24
	Pro�Tools�III
	MIDI Connectivity
	USD Connectivity
	MachineControl

	Audio Requirements
	888/24�I/O
	882/20�I/O
	1622�I/O
	Digidesign ADAT Bridge I/O

	Compatibility Information

	Installing Pro�Tools Hardware
	Macintosh
	Windows�NT
	Expanded Pro�Tools Systems
	The Pro�Tools Cards
	Pro�Tools�24 MIX Hardware
	The MIX Core Card
	The MIX Farm Card

	Pro�Tools�24 Hardware
	The d24 Audio Card
	The DSP Farm

	Pro�Tools�III Hardware
	The Disk�I/O Card
	The DSP Farm

	The TDM Ribbon Cable

	Installing the Pro�Tools Cards
	Macintosh Systems
	Windows Systems

	Connecting an Audio Interface
	Using Multiple Pro�Tools Cards and Interfaces


	Connecting SCSI Drives
	Audio Storage Guidelines
	SCSI Requirements
	SCSI on Power Macintosh Computers

	Formatting Drives for Macintosh-based Systems
	Pro�Tools�24 MIX and Pro�Tools�24
	Pro�Tools�III Systems

	Formatting Drives for Windows-based Systems
	Hard Drives Larger than 4 Gigabytes

	Improving System Performance
	Use High-Performance SCSI Drives
	Use a SCSI Accelerator
	Distribute Audio Across Multiple Drives
	Minimize SCSI Cable Length
	Separate Video and Audio Files

	Connecting SCSI Drives to Pro�Tools MIX and Pro�Tools�24 Systems
	Proper SCSI�Chain Termination

	Connecting SCSI Drives To Pro�Tools�III Systems
	Preparing SCSI Drives on Windows-based Systems
	Formatting and Partitioning Drives
	Optimizing Windows SCSI Drives

	Using Macintosh Drives on Windows Systems
	Installing the MacOpener Utility
	Enabling the MacOpener Driver

	Mounting HFS Drives
	Formatting and Maintaining HFS Drives
	Don’t Use Windows�NT Disk Utility Software on HFS Drives


	Using The Mt. Digi Utility
	Enabling Fast SCSI Transfers
	Adjusting Scan Times
	Mounting Drives with Mt.�Digi


	Connecting Your Studio
	Choosing an Output Mode
	Stereo Mix Outputs Mode
	Direct Outputs Mode

	The 888/24�I/O Interface
	888/24�I/O Front Panel
	1. Power
	2. Sync Mode
	3. Sample Rate and 1–2 Format Indicators
	4. Level Meters
	5. Input Level Trims
	6. Output Level Trims

	888/24�I/O Back Panel
	1. Analog Audio Outputs
	2. Analog Audio Inputs
	3. AES/EBU Digital Outputs 1–8
	4. AES/EBU Digital Inputs 1–8
	5. 50-pin Interface Connector
	6. S/PDIF Digital Input/Output
	7/9. Slave Clock In/Out
	8. Power Input


	Changing Operating Levels of Individual 888/24�I/O Channels
	Making Signal Connections to the 888/24�I/O
	Choosing between +4�dBu and –10�dBV operation modes
	Setting Up Your Studio

	Using the 888/24�I/O Interface as Stand-Alone Audio Converter
	The 882/20�I/O Interface
	882/20�I/O Interface Front Panel
	1. Power
	2. Sync Mode
	3. Ch 1–2 Input
	4. Sample Rate
	5. Signal Present LEDs

	882/20�I/O Back Panel
	1. Analog Audio Inputs
	2. Analog Audio Outputs
	3. Slave Clock In/Out
	4. S/PDIF Digital Input/Output
	5. 50-pin Interface Connector
	6. Power Input


	Making Signal Connections to the 882/20�I/O
	Choosing between +4�dBu and –10�dBV operation modes
	Setting Up Your Studio

	Using the 882/20�I/O Interface as Stand-Alone Audio Converter
	The 1622�I/O Interface
	1622�I/O Front Panel
	1. Power
	2. Sync Mode
	3. Ch 1–2 Input
	4. Sample Rate
	5. Input Meters
	6. Output Meters
	7. Channel 15–16 Direct Inputs

	1622�I/O Back Panel
	1. Analog Audio Inputs 1–14
	2. Analog Audio Outputs L-R
	3. Slave Clock In/Out
	4. S/PDIF Digital Input/Output
	5. 60-pin Interface Connector
	6. Power Input


	Making Signal Connections to the 1622�I/O Interface
	Adjusting 1622�I/O Gain Levels
	Setting Up Your Studio

	Using the 1622�I/O Interface as Stand-Alone Audio Converter
	Connecting Equipment with Digital Audio Ins and Outs
	Connecting Effects Units
	Connecting Effects Units Digitally

	MIDI Connections
	Macintosh
	Windows

	Connecting SMPTE Synchronization Devices
	Pro�Tools and Synchronization
	The Digidesign Universal Slave Driver


	Making Sure Your System Is Working
	Configuring Expanded Pro�Tools Systems
	Starting Up Your System
	Installing the Demo Session
	Macintosh
	Windows

	Opening the Demo Session
	Configuring Pro�Tools for the First Time

	Choosing an Output Mode
	Direct Outputs Mode
	Stereo Mix Outputs Mode


	Determining Slot Order On Macintosh Computers
	Card Order Guidelines for Each Pro�Tools System
	Additional Rules for Card Placement


	Calibrating the 888/24�I/O
	About Calibration
	Headroom
	The AES Standard for Headroom
	The Calibration Process

	Calibrating The 888/24�I/O
	Calibrating a System With Both 888/24�I/O and 882/20�I/O Audio Interfaces


	Hard Drive Maintanance
	Tuning Up Hard Drives
	Avoiding File Fragmentation
	Optimizing Drives

	Formatting Drives
	Low-Level (Physical) Formatting
	High-Level Formatting (Initialization)

	Partitioning Drives
	Seek Times on Partitioned Drives


	Using Iomega Jaz Drives
	Enabling Fast SCSI Transfers With Jaz Drives
	Sleep Mode
	Cartridge Ejection
	Cartridge Care




